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t h a n k  y o u !

This book is self written, self edited, and self published, and although I've tried 
my best to be as accurate as possible with the information on the following pages, 
inevitably there will be errors. Please forgive them. Also, I reference a lot of camera 
brands, software and accessories in this book. While I did not include copyright 
and trademark insignia, please note that all trademarks and copyrights are due 
their respective brands and corporations. 

Copyright © 2018 Mike Neubauer Fine Art Photography, LLC / Neubauer.net 
All Rights Reserved. Reproduction of the whole or any part of
the contents of this book without permission is prohibited.

Designed and Published in Hawai‘i, USA.
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Printed in China.
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There’s something about being out in nature that 
just feels right. I find my sanity and humility 
in the Church of the Holy Pines and Our Lady 
of Flowing Water. It’s hard not to be thankful 
when surrounded by God’s greatest landscapes. 
And being there in the magical moments when 

the light bounces just right off a carpet of green ferns or reflects ever so 
gracefully amongst an incoming tide becomes an ethereal experience. 
Photographing those moments is akin to the greatest victories in our 
profession. If you’re like me, you eat, sleep and breathe to capture the next 
perfect landscape.

With the right schooling, mentors and practice, I’ve gotten to the point 
where I am now able to see the finished product before I ever click the 
shutter. It didn’t come overnight, and there were a lot of questions I had to 
have answered along the way. 

I’m writing this book as a guide, in order to help you answer the questions 
that I needed answering, understand the principles that I needed help 
understanding and give you the tools you need in order to capture epic 
landscapes, like the ones in this book. 

Keep in mind though, that photography is an evolving process. There are 
many tips and techniques that scores of great artists implement which I do 
not. This is simply by choice. I choose to capture and process my images in 
a certain way to tell a certain story. In your studies and development you 
may find your own techniques that work for your style. There is no wrong 
way. Photography is subjective, use it to create your voice and tell your 
story in your own way.

In Hawai‘i, there is an old proverb: ‘A‘ohe pau ka ‘ike i ka hālau ho‘okahi 
- Not all knowledge is learned in one school. Use this book as a guide, but 
seek to develop your skills beyond what you learn here. 

With that said, let’s begin…

INTRODUCTION

I n t r o d u c t I o n
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Before we dive in to the common cameras on the market and discuss the 
best cameras for the everyday landscape shooter, I want to touch a little  on 
medium and large format cameras. We won't talk too much about them 
because they're not all that common in landscape photography, but they 
are certainly worth a few words.

Large format, like the type used by Ansel Adams had sensor sizes of 4"x5" 
or even larger (more on sensor sizes in a few paragraphs). In fact, Ansel 
himself was known to use a camera that shot 8"x10" film! There are still 
large format cameras on the market, but most shoot film. The rare few 
that you may find that are actually digital will cost you about as much as 
a small house.

CAMERA TYPES

c a m e r a  t y p e s
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The term "medium format" refers to any cameras with a sensor size 
larger than 24mm x 36mm and less than 4"x5". There are quite a few of 
these on the market in the digital variety, though most of them will run 
well into the tens of thousands of dollars. 

Although their price requires a serious commitment, the images from 
a good medium format camera are amazingly crisp. One of the down 
sides to the medium format is that there are very few ultra wide angle 
lenses available for these cameras. As you'll find out in the next chapter, 
ultra wide angle lenses are essential for us landscape folks. If money 
is of no concern you may want to look at some of the medium format 
cameras that are out there. For the rest of us...

We could discuss all the different types of cameras here and go on for 
days, but to keep it simple, I want to focus on the two most popular 
types of cameras for today’s landscape photographers. Those are the 
DSLR and the Mirrorless camera.

DSLR cameras, or Digital Single Lens Reflex cameras are the digital 
equivalent of the 35mm interchangeable lens cameras that were used 
by professionals and amateurs alike for generations. The benefits to 
these cameras are huge and the vast majority of professional landscape 
photographers today use some type of DSLR cameras.   
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Yes, but what exactly is a DSLR? 

DSLR cameras do not have a fixed lens like the entry level point and shoot 
cameras do. This means that the photographer has the versatility to attach 
any lens he or she desires in order to capture the scene as they see fit.

In a DSLR camera, light passes through the lens and is reflected by a 
mirror (green) through a pentaprism (orange) and is reflected back again 
to the photographer through the optical viewfinder (yellow). This allows 
the shooter to see about 95-98% of what the composition will look like once 
they press the trigger.

When the photographer does press the trigger, the mirror raises up, 
allowing light to pass through the shutter (blue) and onto a digital sensor 
(red). When the image is captured on the sensor, the shutter closes and the 
mirror flips back down.

Mirrorless cameras start with the same concept, but instead remove the 
mirror (hence the clever name - mirrorless) and the pentaprism. This 
allows the camera body to be much thinner and lighter.  It also allows for 
higher fps (frames per second) rates and an electronic viewfinder with 
100% of the composition in view.

Like DSLRs, mirrorless cameras also allow for interchangeable lenses, 
allowing the photographer to choose the right lens for every scene.

Before you jump in and decide you need a mirrorless camera, there is one 
major factor that needs to be addressed: sensor size.

c a m e r a  t y p e s
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Although many people will tell you sensor size doesn’t really matter, the 
simple truth is that it does for several reasons. First, the general rule of 
the larger the image sensor the better quality the images, does in fact ring 
true. Essentially, the image sensor uses light to create an image. The more 
light-sensitive photosites a sensor has, the more information it can record, 
resulting in - you guessed it, better images.

The second reason sensor size matters is because of what is referred to as 
Crop Factor.

What is crop factor you ask? Well, to understand this we must refer back 
to a traditional 35mm film camera. The size of the film strip was 35mm. 
In the digital world, the sensor replaces the film strip. And a “full frame” 
sensor is the equivalent of that 35mm film strip.  

Following so far? Good. Now it gets a little more confusing, but stay with 
me…

Years ago, when I learned to shoot photography, there were no digital 
cameras (yes, I’m that old). Most photographers shot 35mm cameras and 
we knew based on the focal length of the lens what we could expect from 
each lens. For example, the 50mm lens would act most similarly to the 
human eye, giving a very natural perspective. Lenses with shorter focal 
lengths would give wider fields of view and lenses with longer focal lengths 
would give more of a telephoto view.

Lenses are circular, and theoretically could capture round images. This 
didn’t work back in the film era because the film wasn’t round, it was on 
a strip, and therefore rectangular images were captured instead. When 
digital cameras were introduced, the sensor was created in a like format, 
cropping what the lens saw down into that set rectangular size. Thus, the 
field of view on a full frame camera is equivalent to the field of view of a 
35mm camera.

c a m e r a  t y p e s
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Couldn’t they have just made round sensors? Sure, I suppose they could 
have, but the ramifications would have been exponential.

A full frame DSLR camera has a sensor size of 24mm x 36mm. Some digital 
cameras today have smaller (cropped) sensors, which in turn means they 
don’t actually capture the same amount of information as their full framed 
big brothers. Even though many of them use the same lenses, the field of 
view changes as the sensor is cropped, leading to the “Crop Factor.”

FuLL Frame sensor cropped sensor
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These cropped sensor cameras are often referred to as Micro Four Thirds, 
APS-C, Foveon, Nikon CX, etc. and they all have different crop factors. The 
most common in DSLRs are the APS-C. These sensor sizes are 15.6mm x 
23.5mm (Nikon) and 14.8mm x 22.2mm (Canon), resulting in a crop factor 
of 1.5x (Nikon) or 1.6x (Canon). Below are some common sensor sizes and 
their relative crop factors:

So, to calculate the actual field of view equivalent on a full frame camera, 
we would take the focal length of the lens and multiply it by its crop factor 
on the camera body to which we are attaching it. For example, if we have 
a 50mm lens and we are attaching it to a Nikon APS-C camera, we would 
take 50 (focal length) x 1.5 (crop factor) = 75mm. This means when we 
attach a 50mm lens to a Nikon APS-C sensor we will get the same field of 
view as if we put a 75mm lens on a full frame camera.

nIkon cx 2.7x

oLYmpus mIcro Four ThIrds 2.0x

panasonIc mIcro Four ThIrds 2.0x

canon eF-s / eF-m 1.6x

sIGma Foveon dc 1.7x or 1.5x

penTax da 1.5x

sonY e-mounT 1.5x

samsunG nx 1.5x

nIkon dx 1.5x

c a m e r a  t y p e s
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OK, so why does this matter?

For Landscape photographers, like you and I, we tend to shoot a lot of 
sweeping panoramas and ultra wide angle images. This means we like to 
have the widest possible lenses on our cameras. And for this reason, most 
landscape photographers prefer to shoot with full frame cameras. If this 
isn’t you, and you prefer to shoot birds, wild game or other compositions 
where you cannot get too close to your subject, then you may want a bit of 
a crop factor. It all depends on the type of photography you specialize in.

Mirrorless vs. DSLR, which is better?
That, my friend, is a loaded question and the answer may be different by 
the time you read this. At this time, I prefer DSLR cameras. If you own a 
mirrorless camera, don’t fret, it’s still a great camera and it may be better 
suited for your type of photography, but let me explain why right now I still 
like DSLRs better.

First and foremost, I shoot with full frame cameras. And yes, there are full 
frame mirrorless cameras - Sony and Leica both have full frame mirrorless 
systems, but in my opinion they just aren’t there yet. The camera bodies 
may be slightly smaller and lighter weight, but many of the lenses are 
actually bigger and heavier than their comparable DSLR counterparts. 
When you carry multiple lenses around, this tends to make your camera 
bag heavier with a mirrorless setup.



A second point to consider would be the lack of lens options available at 
this time. There are many great lens manufacturers that are not Canon 
or Nikon. Yet, few make lenses for mirrorless cameras, especially full 
frame mirrorless cameras. For that reason you become stuck using the 
manufacturer’s brand lenses. Sony and Zeiss make very nice lenses, but 
they are expensive. A little competition would allow me to spend a bit less 
on lenses I use less frequently but still want in my quiver. 

Battery life is another issue. Since mirrorless cameras don’t have an accurate 
optical view finder (OVF), they have to use an electronic view finder (EVF).  
This can be a good thing, because the view finder actually covers 100% of 
the frame, whereas OVFs only cover about 95-98%. However, since they are 
electronic they use battery power, and a lot of it. Battery life on a mirrorless 
camera is roughly 1/2 to 1/3 of what a traditional DSLR will give you. So 
you will basically need to carry two to three times the amount of batteries 
with you as compared with the DSLR.

All this relates only as a comparison between full frame DSLRs and full 
frame mirrorless cameras. If we were to compare cropped sensor DSLRs 
with comparable cropped sensor mirrorless cameras, my view would be 
much more in favor of the mirrorless system. But since I am personally an 
advocate for full frame cameras, I will stick to a full frame DSLR.

That’s not to say the technology isn’t improving. On the contrary, mirrorless 
camera makers are making huge strides and the innovations are growing at 
a substantial rate. It may just be a matter of time before technology catches 
up and full frame mirrorless cameras become superior in every way when 
compared to DSLRs. As of right now, the quality of images coming from 
full frame DSLRs and the options and advantages that come with them are 
better than their mirrorless counterparts - in my opinion.

UPDATE:  As I’m writing this, Hasselblad just released a mirrorless medium 
format camera. Fuji has also announced one. I haven’t had a chance to see 
either one for myself yet, but these could absolutely be game changers… 
and bank breakers… 

c a m e r a  t y p e s
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Arguably, lenses are the most important factor when it comes to camera 
gear. Good lenses will far outlive any good camera body, so if you are 
working within a budget, spend the bulk of your money on the lenses. 

You will likely have them for many years, while the camera body itself 
will likely only give you a few years before you’ll want to upgrade. Most 
major camera manufacturers have their own brand lenses and these are 
often great options, but there are a few things you should know before 
purchasing camera lenses.

Perhaps the first thing you should be aware of is that camera manufacturers 
such as Nikon, Canon, etc., make both amateur and professional grade 
lenses. Sometimes they appear very similar, and sometimes they are 
relatively similar, but the difference in pricing may be dramatic.  So what 
makes the prices so much more on the professional level lenses?

L e n s e s

LENSES



Let’s start with craftsmanship. Most amateur level lenses are assembled in 
batches by machines with little quality oversight. Even the same lenses will 
vary from one to the next.  Even though amateur lenses may still go through 
a high quality manufacturing process, many of the elements that go into 
the production of these lenses are lesser grade materials. Professional 
grade lenses will use the best possible brass and metal components where 
amateur lenses will use plastic parts.

The glass that makes up these lenses is the most striking difference. Some 
of the less expensive lenses will use acrylic elements or glass with naturally 
formed bubbles. This is common practice throughout the industry. 
Professional grade lenses are hand crafted and assembled by engineers. 
Quality of the glass is of utmost importance to discerning photographers, 
and the clarity and sharpness from corner to corner of the frame are 
unparalleled in the professional grade lenses. The glass alone goes through 
a rigorous inspection process before they are boxed and shipped.

Professional level lenses are designed with complex optical formulas 
to reduce or correct different types of lens aberrations. Because of this, 
these lenses tend to be larger, heavier and incorporate more elements 
than their amateur grade siblings. The glass elements in the professional 
lenses are made with special coatings which reduce glare, ghosting, and 
lens flares while increasing sharpness, contrast and colors. Without these 
considerations, amateur grade lenses tend to have a bit more chromatic 
aberration, image distortion and vignetting.

L e n s e s
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Okay, I can’t go any further without talking about aperture. We will have a 
whole chapter on this later, but for now I want to go into the basic principles 
of aperture and how it relates to the construction and cost of lenses.

First, what is aperture? Let’s start with a visual. Imagine you are standing 
in a 10 foot by 10 foot room with only one very small window across the 
room. That tiny little window is your only light source, and because it is so 
small, it takes a long time to bring enough light into that room in order for 
your eyes to focus. If you had your eyes closed for a few minutes and then 
opened them it would likely take you a couple seconds to see the couch on 
your left or table on your right. Think of that tiny window as your smallest 
aperture, an f22 for example.

Now imagine the same room, but the window takes up nearly the whole 
wall. When you open your eyes after having them closed for a few minutes 
you can nearly instantly see everything in the room. This is a wide aperture, 
an f2.8 for example. Don’t ask me why the bigger window has the smaller 
number, we may get into that later (it has to do with physics), but for now, 
just try to follow along…

Wider apertures allow you to bring in more light and in turn focus faster 
and shoot faster images than smaller apertures. Wider apertures also allow 
for a shallower depth of field, meaning you have more ability to blur out 
a background and focus on a sharp foreground element. The out of focus 
highlights in images created with wider apertures is known as bokeh, and 
images with a lot of bokeh can often look very appealing.

L e n s e s
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Professional lenses have constant apertures as opposed to variable apertures 
that amateur level lenses have. What this means is say you have a 16-35mm 
f2.8 L Canon lens. This is a very good and popular ultra wide professional 
lens. The f2.8 is your aperture and the 16-35 is your focal length. This means 
that at 16mm all the way through 35mm, this lens has the ability to shoot 
with a wide open aperture of f2.8. Now let’s look at a Canon 18-55mm f3.5-
5.6 lens.  This is an amateur grade lens. It tells me that at 18mm the lens can 
shoot at f3.5 at its widest. When it is zoomed in to 55mm, the lens can only 
shoot at f5.6.  That is a significantly smaller window.

Another significant difference between pro and amateur lenses has to do 
with autofocus speed. Typically, pro lenses have very fast internal focusing 
motors while the amateur line tends to lag. This makes a big difference when 
it comes to shooting wildlife, or action photography. While its applications 
may seem inconsequential to landscape photography, I promise you, they 
are not.

The final aspect I’m going to point out here, is weather sealing. For the 
way I shoot, this makes the biggest impact. Good lenses are going to have 
protection from extreme heat and cold and also be pretty water resistant. 
A consumer level lens may fail in a good rain or from being splashed by 
the ocean (salt water is the worst… believe me). Having weather sealing on 
my gear is absolutely essential. The last thing I want is to be on a shoot in 
Iceland or the Sahara and have my equipment fail. Weather sealing alone 
has saved me numerous times in rough situations and I wouldn’t buy gear 
without it.

For all these reasons, plus all the research and development that goes into 
the professional level lenses, they do cost more - sometimes it can be a 
significant amount more. However, if your wallet allows for it, pro line 
lenses are worth the extra coin.

L e n s e s
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Prime Lenses, Zoom Lenses and Specialty Lenses

Prime lenses have fixed focal lengths. A 50mm prime lens, for example, 
does not zoom in or out.  In order to do that you would need to take a 
physical step forward or back. That’s your zoom. A benefit of prime lenses 
is they usually have very wide apertures. It is not uncommon for these 
lenses to be f1.8 or even wider. A 50mm prime lens (75mm on APS-C 
camera body) is a very nice portrait lens, and having a wide aperture like 
these do make them excellent for portraiture. Wider angle primes, in the 
14mm - 24mm range give a nice perspective and are very nice for landscape 
work. 135mm or 200mm primes offer a great telephoto lens and are good 
for shooting wildlife.

Zoom lenses are a bit more versatile, but do have their drawbacks. To be 
clear, a zoom lens is any lens that has adjustable focal lengths. For example, 
a 28-135mm lens has the ability to be used at any focal length between 28 
and 135 millimeters.  Again, there are drawbacks. These lenses usually (but 
not always) have smaller apertures than primes. 

L e n s e s



While these are the two most common types of lenses, there are many 
specialized lenses we should talk briefly about as well.  

Fisheye lenses have convex front elements that exploit distortion and create 
quite surreal scenes. Images tend to look rounded from the distortion, 
especially near the edges of the frame. These lenses would be considered a 
specialty lens because they are often not used with any sense of regularity. 

Tilt-Shift Lenses are highly favorable by architecture photographers as they 
try to reduce distortion and achieve straight lines while giving interesting 
depth of field options. Tilt-shift lenses give the photographer the ability to 
rotate the glass elements inside the lens, which in turn changes the depth 
of field from extremely shallow to very deep.

Macro lenses are popular with many photographers as they allow the 
shooter to get up close and personal with their subjects. While most lenses 
have a minimum focusing distance of at least a foot or two, macro lenses 
have the ability to focus within inches of their subjects, often providing 
detailed shots that resemble a view from a microscope.

The Best Landscape Photography Lenses
So now that we have talked about the differences between pro and amateur 
lenses, and some of the more common types of lenses, let’s talk about the 
best lenses for landscape photography. Of course this is all opinion based, 
but I’m going to tell you what works for me, and what I can’t do without.

To me, there is a trifecta of lenses that I feel are essential. I have more 
than just these three lenses, but these three lenses see about 99% of all my 
shooting.  No kidding, they really do. Those three lenses are: the ultra wide 
14-24mm f2.8, the mid range 24-70mm f2.8 and the telephoto 70-200mm 
f2.8.  Here’s why I find these so indispensable:

L e n s e s
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Ultra Wide Zoom
First and foremost, you NEED a wide angle lens if you are going to shoot 
landscape photography. Anything wider than about 17mm on a full frame 
camera (10-12mm on APS-C) will be sufficient. You will likely find yourself 
using this as your go to lens. As you start getting down below 20mm in 
focal length and wider than f4, prices on these lenses do tend to sky rocket, 
so beware. If you are budget conscious you can find prime lenses around 
the 20mm to 24mm range that are not too expensive. 

You can also find ultra wide zoom lenses which are very common and are 
typically the preferred lenses amongst landscape photographers. There are 
some very nice wide angle zoom lenses available with fast apertures and 
great glass from all the major camera and lens outfitters. Nikon’s 14-24mm 
f2.8 is absolutely incredible and Canon’s 16-35mm f2.8 is no slouch either. 
Both lenses offer excellent optics and a versatile zoom range. I personally 
shoot Nikon cameras and one of my camera bodies ALWAYS has the 14-
24mm lens attached to it. Many times, it's the only lens I’ll even bring with 
me on a shoot.

Midrange Telephoto Zoom
Midrange telephoto lenses like the 24-70mm f2.8 (available from most 
camera manufacturers and lens producers) are extremely versatile. Often 
referred to as “walk around lenses”, these are great lenses when you don’t 
know what to expect. Their range allows you to have a relatively wide angle 
for shooting most landscapes and gives a nice zoom which allows for some 
wildlife, texture and creative shooting. The fast aperture is helpful when 
using this lens without a tripod.  

Many times when I’m traveling and don’t know exactly what I’ll encounter, 
this is the lens I will keep attached to my camera. The versatility and 
quickness of this lens is excellent. Definitely one to keep in the bag.

L e n s e s
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Telephoto Zoom
Although this lens is the one I pull out the least of these three, it is still hard 
to live without.  I use this lens (70-200mm f2.8) when shooting subjects 
that are farther away than I can access, like a waterfall across a large divide, 
or an ocean wave where I don’t have water housing and I want to fill the 
frame with the curling surf. This lens is so fast and so sharp, I can shoot it 
hand held, though the weight of it is significant and I wouldn’t want to do 
this in one location for very long.

As I travel quite often, I like to keep my camera bag as light as possible. Plus 
there is all kinds of other gear I like to bring with me. With the range of 
the above three lenses, I can capture just about any scene I could ever want. 
For that reason, these are usually the only three lenses that I take with on 
landscape shoots. Of course, certain situations call for different lenses, but 
99% of the time, these 3 lenses cover all your bases. …In my opinion.

L e n s e s
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Essential Gear

Most photographers have all kinds of gear. Landscape photographers are 
no different. There’s a plethora of gadgets on the market that we think we 
absolutely must have in order to get the shot, or that by having more toys it 
somehow make us better photographers. I personally, don’t believe that is 
the case. In fact, I’m something of a minimalist. I like to travel as light as 
possible yet still want the ability to capture every scene. So, this is my list of 
essential gear; stuff that I can’t go without. 

Flash
Nope, scratch that. I don’t use a flash. Seriously, I don’t even own one. I’m 
an all natural kind of guy and I do what I can to work with the light that 
is given to me. I don’t use props and I don’t use flashes. I know a lot of 
photographers who do and get some nice results with them, but you’re 
reading my book, and I say no to the flash. ;-)

Tripod
Yes. I can’t stress the importance of this one enough. I’ve been fortunate  to 
travel to many places around the world. Some of these places are ripe with 
photographers and aspiring photographers. Many times the photographers 
I run into have nice cameras and lenses, but cheap tripods. Seeing this 
makes me shake my head. A good tripod makes a HUGE difference. 
Seriously. I know it may seem like another crazy expense, but a solid set of 
legs will last forever (or close to it, if you aren’t crazy with your gear). 

I shoot EVERYTHING on a tripod. Why? Because my camera and lenses 
are heavy. Sometimes I get only a few minutes of good light, and I have to 
be setup and ready to shoot. If I’m already balanced and ready to go on a 
tripod, all I need to do is fire away when that right moment comes. Hey, I 
don’t know the next time I’ll be hanging off a 400’ waterfall in Iceland, so I 
want to make sure I don’t have to reshoot that scene!

e s s e n t I a L  g e a r
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There are a lot of tripod manufacturers out there, and a lot of good legs on 
the market. Here are a few things to keep in mind when you are buying your 
next tripod. First, make sure that it extends to eye level for you -without 
extending the center column. In fact, throw the center column away.  Don’t 
ever use it. It just gets in the way, and it's too unstable for just about any 
kind of shooting. I’m not joking about this, seriously, don’t ever use it, you 
will likely wind up with images that are blurry.

Next thing to think about is weight. Make sure your tripod supports the 
weight of your camera and lens. Some tripods are only rated for 10 pounds 
or so. Think about the gear you are carrying, the heavier duty gear you carry 
the more you need to support it.  Think of it like this, do you want a couple 
of twigs holding up a bowling ball?  Not if my baby is under that bowling 
ball, I don’t. Thin legs bend in moderate winds, you want something that 
will be heavy enough to hold firm in all conditions.  

Another consideration is making sure the tripod’s legs can extend 
horizontal. Many times I like to be on the ground, as low as possible getting 
the shot. Some tripod legs only extend to a certain level, or worse yet, they 
are connected together with a cheap piece of plastic. Don’t buy one of those. 
Make sure your tripod legs are as versatile as the shots you hope to capture.

e s s e n t I a L  g e a r
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Finally, tripod legs have traditionally been made of aluminum. There are 
many degrees of aluminum, some good, some bad. While some aluminum 
tripods are very stable and can hold a heavy camera system, often times 
they can be quite heavy. That’s kind of been the tradeoff.  Some tripods 
are made of carbon fiber. These are becoming much more popular, and 
like aluminum tripods there are varying degrees of quality. While they 
will certainly cost more than aluminum tripods, carbon tripods generally 
weigh much less. If you are traveling or hiking a lot with them, consider a 
carbon fiber tripod a worthwhile investment.

To me, there are two brands that really stand apart when it comes to solid 
carbon fiber tripod legs. Those are Gitzo and Really Right Stuff. Both make 
exceptional gear and while pricey, there’s a good chance you may never 
need to replace a set of legs from one of these companies.

Ballhead
You've got to have something to throw on top of that set of legs, and a 
ballhead has been the choice of most pros for a very long time. There 
are many good ballheads on the market, so this one is a little tougher to 
breakdown, but there are a few things to consider. 

First, find out what the load bearing capabilities are of the ballheads you 
are considering. Make sure they can handle the weight of your camera 
system with your heaviest lens. 

The next thing to consider is the creep of the head. Meaning when you lock 
your camera in place, how much it actually moves from the time you take 
your hands off the mechanism.  Most of the time it is virtually nil, but some 
ballheads have quite a bit of creep. This can get a bit annoying when you are 
framing that shot up “just right.”

e s s e n t I a L  g e a r
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Finally, the all important matter of weight. For me, I like to shave off weight 
anywhere I can. There are a lot of good heads with low profiles (actual 
height of the ballhead) and low weight. That’s where I tend to stay.  Some 
of the better ones from Markins and Really Right Stuff are great. Induro 
has a BHL line of ballheads that are really nice as well. They are low weight, 
low profile and have big knobby controls, which work really well in cold 
weather when you don’t want to be fiddling with taking off your gloves…

Cable Release
Especially if you have a cheaper tripod or ballhead, this is essential. 
Sometimes these are called shutter releases or intervalometers (well, 
intervalometers are a bit more advanced, and have a few more features, 
but can be used as cable release as well). The cable release allows you to 
shoot your camera without touching the camera itself. Usually, this is done 
by means of a cable (clever with the naming, huh?), but there are many 
wireless versions available too. Some newer cameras even have apps so you 
can use your iPhone as a remote shutter release. The theory is, any time you 
touch your camera you have the potential of moving it slightly. With slight 
movement while the camera is functioning you will usually get a little bit 
of blur. A simple cable release will help avoid this. Amazon sells some basic 
ones for under $10 for most cameras.

Filters
Filters add a world of possibilities to your photos, and there are a world of 
options with filters as well. I actually use filters a lot less than most of my 
contemporaries, but there are a few that I rarely leave home without. As 
mentioned above, there are a lot of different filters out there, and the plain 
truth is you don’t need that many. Yes, they all have their advantages and 
disadvantages, but many filters can be applied in post production and are 
unnecessary to throw on your lens while shooting.

e s s e n t I a L  g e a r
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In addition to adding effects to your photographs, filters also provide a little 
bit of protection against scratches, breaks and fingerprints on your lens. 
Take it from me, I once fell while hiking a steep cliff on Maui and landed 
on a backup camera with a  Canon 16-35mm lens attached to it. That piece 
of glass at the time cost about $1500, and would’ve been shattered if I didn’t 
have a circular polarizer on it. Fortunately, I was only out the money for 
one polarizing filter!  

To me, there are only a few essential filters. One is the aforementioned 
polarizing filter. These are great to give you depth in clouds and also dispel 
glare on water.  Of all the filters out there, these ones are pretty much 
impossible to duplicate their effects in Photoshop. 

The next filters I recommend are neutral density filters or ND filters. These 
come in many variations so let’s talk about a few. First though, what does 
an ND filter do, exactly? Glad you asked. A neutral density filter is like 
having sunglasses on your camera. These filters typically darken the image 
by a set amount, be it 1 stop, 2 stops, 10 stops or a graduating range. 

e s s e n t I a L  g e a r



A little aside here. I know many of you are wondering what is a “stop”? Well, 
in photographic terms, we can either increase or decrease our exposure by 
stops or fractions of stops. Think about it like this: when we increase our 
exposure by one stop we need to either double the length of our exposure 
or double the size of our aperture. To decrease a stop, we would cut our 
exposure length in half.  

Why might we want to increase our exposure times with an ND filter? Ah, 
glad you asked. Sometimes we want to trick our camera into thinking it's 
darker than it is so that we increase our exposure and in turn increase 
the motion of anything not set in place in our image. For example, water 
or clouds. A lot of the waterfall images you see in magazines, websites, 
galleries, etc. are taken with ND filters, since they are often shot during 
the day, and usually have a “soft” water effect.  This is due to increasing our 
exposure time with a neutral density filter.

e s s e n t I a L  g e a r

Above we have two neutral density filters. The first one (left) is a soft edge 
graduated ND filter. You can see that filter slowly changes from semi-
opaque to transparent. The image on the right is a six stop neutral density 
filter. The darkness of this filter when put over the lens tells the camera to let 
in more light to compensate for the darkness, resulting in longer exposures.
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So what is a graduated neutral density filter and what does it do? Most of 
the time graduated ND filters are clear on one side with a gradient towards 
a one or two stop darker end. These are great when shooting images where 
there is a noticeable difference between dark and light in the scene, such 
as a sunset. Usually, sunsets are so bright in one quadrant of your frame 
and the rest of the landscape appears much darker in the other. In order to 
balance out the colors a bit, we could put that darker area of the graduated 
ND filter over where the sun is, and let it fade to clear in the foreground. 
This will give a nice balance to the final image.

I have quite a few of these filters. Most commonly, I use a 2 stop, 3 stop, 
6 stop and 10 stop neutral density filters. I do use graduated ND filters as 
well, though the light of the scene will dictate how dramatic a gradient I 
will use.

These are the most common filters I use. Definitely you want to make sure 
you have a polarizer, and it's a very good idea to have a few ND filters as 
well. With these in tow, you should be good to go!
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Like I mentioned earlier, I don’t always use filters, but when I do I make 
sure I spend the money on good quality products. I mean, why spend all 
that money on pricey lenses just to put a cheap piece of glass in front of 
it. The clarity of that junk glass will negate the thousands of dollars you 
just spent on that killer lens. So, pony up. You get what you pay for in this 
field and as you will learn if you haven’t already, photography can be a 
ridiculously expensive hobby.

Other stuff:
Make sure you have several lens cloths on hand. You’ll likely use a lot of 
them, lose them or dirty them up substantially. Be prepared with lots of 
extra batteries and memory cards too. And get a nice bag to carry all of 
your stuff in. The good bags are padded all around and inside, protecting 
your valuable investment.

e s s e n t I a L  g e a r

Here's some of the gear I like to make sure I've always got with me.
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Cleaning Your Gear

If you ever see any of my gear up for sale on Craigslist or eBay or anywhere 
else for that matter, don’t buy it. I am brutal with my equipment. I push 
them to the limits and by the time I’m ready to upgrade, there’s not much 
more punishment I can put my camera, lenses and tripods through. 

In all honesty, if I didn’t clean my gear as often as I do, it would never last as 
long as it does. Some elements are easy to clean, some a little more difficult, 
and sometimes it's a good idea to send it in to the manufacturer to have 
them clean it for you. 

Dirt, dust, sand, salt and water are all notoriously bad for your gear. 
Especially that gear with electronic components. Since I live and do most 
of my work in Hawaii, the salt, sand and water are my biggest problem 
areas. Salt water itself is a camera killer. I don’t think my cameras would 
last a week if they weren’t weather sealed. Even as they are weather sealed 
and my lenses are of the highest quality available, salt and water still tend 
to find their way into everything. So staying on top of that and cleaning 
camera gear religiously is imperative.

Tripods: Most tripods can be taken apart and cleaned out. I make sure to 
spray off my tripods with fresh water immediately after a shoot, but if I get 
sand or salt build up in the legs, then I have to take it apart to clean it. 

All the tripods I have use the twist lock legs, and by twisting them as far 
past the open area as possible, it releases the leg section itself to be pulled 
straight out. Inside there are usually a couple of plastic brackets that hold 
the leg in place. Put these aside and be careful not to lose them. Once taken 
apart, everything can be sprayed out with fresh water. When all the salt, 
sand, dirt, mud, etc. is out of the system, apply a small amount of grease to 
the threads of the sections before putting the tripod back together. This will 
ensure smooth action with the legs.

c L e a n I n g  y o u r  g e a r
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Lenses
If you get dirt, dust or other material inside the lens itself, you have to send 
it in to be cleaned, in my opinion.  The last thing you want to do is start 
taking apart the lens and mess up some of the internal components. You 
may need a new lens…

It's a good idea to clean your lenses regularly as it will help preserve a 
smooth operation in your zoom and focusing rings. 

c L e a n I n g  y o u r  g e a r

With your lens off the camera, check the 
lens contacts at the back of the camera.  
Make sure they are clean and clear of dirt 
and grime. If you have a zoom lens, make 
sure the zoom is all the way out, and start 
with a soft bristle brush to remove dirt 
and debris from all exterior components 
of the lens.  I also use a hand air blower 
(DO NOT USE CANNED AIR) to remove 
particles from the surface of the lens. If you 
don’t have one, you should get one. They 
look like a little rocket, and perform in a 
way that they blow air out without sucking 
any back in.
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To clean the surface of the lens, use a microfiber cloth. Start in the center 
of the lens, and wipe the cloth in a circular motion until you get to the edge 
of the glass. If you have smudges or other pesky areas, use a high content 
Isopropyl Alcohol (not water), and apply it directly to a lens wipe or lens 
tissue and use just like you would with the microfiber cloth.  The higher 
the amount of alcohol, the less water in the solution and better it will be for 
your camera. This can be used to clean the lens contacts as well.

Although it may be convenient, try to avoid using regular household 
cleaners like windex, paper towels or Kleenex when cleaning your gear.  
This can cause more harm than good.

Camera
The camera itself can be cleaned much the same way as the lens, with all 
the same tools, with the exception of the sensor. The camera sensor is 
extremely sensitive and many photographers choose to send in their gear 
to have it professionally cleaned as opposed to cleaning it themselves. If 
you don’t feel confident with this, by all means, send in your gear.  If you 
do want to attempt to clean your sensor on your own, here’s some best 
practices that I recommend:

c L e a n I n g  y o u r  g e a r
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Start by turning your camera to “sensor cleaning” mode in your settings 
(if you are using a DSLR camera). What this will do is lock your mirror 
in the “up” position until you have finished your cleaning. Take and face 
your camera toward the ground. Remove the lens or body cap and start 
by using the hand air blower inside the camera to try to rid the sensor of 
any dust. The opening should be facing the ground so all the dirt, dust and 
debris particles fall to the ground and not back into your camera. Once 
you’ve given a sufficient amount of air, you may need to run a test shot to 
see if you were successful in removing all the spots from your sensor. If so, 
great!  You’re done. If not, repeat a few times. If still unsuccessful, move on 
to step two.

Your camera sensor is extremely sensitive and fragile. Do not ever touch it 
and only work on it if you are comfortable with the risks.  Those risks being 
if you mess this up you may need a new camera. OK, on to step two…

In a clean, dust free (or as much 
as it can be) environment (turn off 
any fans, AC units, heaters, etc.) 
you’ll want to set the camera on a 
stable surface and wipe the sensor. 
To do this, I recommend using 
Visible Dust swabs.  They are 
the best product I have found for 
cleaning sensors. Not inexpensive, 
but they are very good. The key 
with these sensors is to make 
sure you get the right ones. Some 
are sized for full frame cameras, 
others for cropped sensors. Their 
website will help guide you to the 
right product for your camera.

c L e a n I n g  y o u r  g e a r
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With the Visible Dust sensor swabs, just use a small amount of the solution 
they give you. Put it on the tip of one swab and wipe across the sensor. 
That’s it. Do not re-use sensor swabs as you are likely to put all the dirt you 
picked up right back onto the sensor. Take a test shot of a white piece of 
paper or some other clean white surface to see if you got it all. If you didn't 
the dust or dirt will clearly be visible on your test image when you zoom in. 
Load up another swab and try again. Repeat until clean.

Of course, if you can avoid getting your camera dirty or changing lenses in 
the field you will avoid the need to clean your camera or sensor, so that’s the 
best first step. But if you do happen to dirty your camera, lenses, tripod or 
other gear, the best thing to do is to clean it right away. Don’t let anything 
build up and certainly don’t let salt water sit on a camera at all, it will start 
corroding your gear.

In the event that you dump your camera in the drink
Keep a bag of rice on hand. I seriously have a one gallon ziplock bag with 
probably 3 cups of rice in it in my truck at all times. Unfortunately, I have 
lost several cameras to the ocean, but I’ve saved several more with a bag of 
rice. 
 
Immediately after retrieving your camera, dry it off as best as you can. Wet 
a cloth with fresh water and wipe down the camera and/or lens thoroughly.  
When you are able to get out of the elements, remove everything from the 
camera (memory cards, batteries, etc.) and place in the bag of rice. Seal the 
bag and let it sit for at least 24 hours. After that put it back together, say 26 
Hail Mary’s and 11 Our Father’s and see if you can get it to fire up. It doesn’t 
always work, but it’s the best option you have given the circumstances.

c L e a n I n g  y o u r  g e a r
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The Basics

This section is going to be broken down into the most essential elements 
needed to be a great landscape photographer, or any type of photographer 
really. Soak this in, you’ll want to know it up, down, left, right, sideways 
and inside out.  Let’s get started.



File Types

There are two basic file types when it comes to digital photography: JPEG 
and RAW format. I’m going to make this real simple, only shoot in RAW. 
If you are a self respecting photographer you have to shoot your images in 
RAW. Period. Here’s why:

Jpeg mode is a heavily compressed file type. What you see is what you get 
with jpeg files, what I mean by this is that there is very little information in 
the file itself, so it can’t really be edited without LOSING information. This 
means every time you go in and edit a jpeg file you are actually degrading 
the image itself. 

You may be saying “Yes, but my jpeg images look better than my RAW 
images.” Well, that’s because your RAW files are just that, raw. They are 
meant to be edited. They hold all kinds of information which lets you 
technically correct an image that may not have been shot correctly or may 
have areas you want to touch up. Jpeg images are not meant to be edited.  

This is why RAW files take up a lot more space on your hard drive than 
Jpegs. So, if you’re thinking “Mike, I don’t have that much room on my 
hard drive, I have to shoot in JPEG,” then stop right here. Go out, pick 
yourself up a backup hard drive and start dumping your files on that. As of 
this writing a 3 terabyte backup hard drive will cost you around a hundred 
bucks. Pony up. By the time this book gets printed you’ll likely be able to 
get a 64 terabyte drive for that price. Memory is cheap. Go get some and 
then read on.

So, if you’re not doing so already, change your file type from JPEG to RAW. 
You will thank me later…

F I L e  t y p e s
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The Exposure Pyramid

Most landscape shooters use only natural light when out photographing. 
So the trick is understanding the exposure pyramid to get a perfectly toned 
image. What is this exposure pyramid I speak of? Simple, it consists of 
aperture, ISO and shutter speed and how they all work together. 

Let's get started by looking at aperture...

t h e  e x p o s u r e  p y r a m I d
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Aperture

Aperture seems to be the most confusing element of photography for new 
shooters, but in my opinion it is probably also the most important. So what 
is it, exactly? Well, let’s break it down. Aperture is essentially the opening 
in a lens that lets light pass through it and record onto your sensor.  The size 
of that opening (aperture) controls how much is in focus and how quickly 
an image will take to capture.

Do you remember in the early part of this book when we were using the 
analogy of the room with the different sized windows and how that related 
to aperture? If not, here’s another explanation.

A photography lens and its aperture try to mimic what our eyes do.  Our 
pupils dilate and constrict depending on how much light is around us, right? 
Well, our lenses do the same thing. In photography, aperture is expressed 
in f-stops or f-numbers. These f-stops describe how wide an aperture is. 
The smaller the f-stop, the wider the aperture, and vice versa. I know it’s 
confusing, but that’s the way it is. Trust me, wrap your mind around it and 
it’s all easy after this…

a p e r t u r e
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If we are in low light situations, our eyes get extremely dilated (big pupils). 
To mimic that, our lenses have super wide apertures (f1.4, f2.8 etc.). If you 
go into a dark room and look around your eyes will be heavily dilated (wide 
aperture). You may also notice that you have a hard time focusing on more 
than one item in that room and that it takes a while for an item to come into 
focus. The same is true with a wide aperture, other than the item you are 
focused on, the rest of the scene will be more or less out of focus the wider 
your aperture is.

When you are in a well lit room, it is easy to focus on everything around 
you. Here your eyes are more constricted (smaller pupils) The same is true 
with a small aperture like an f18 or f22.  If you think about aperture in 
terms of how much is in focus, small apertures will have most of your scene 
in focus while larger apertures are focusing on a single element. 

In truth, your focus area is a set distance from your camera. This is set by 
the focusing ring. A large aperture will focus very close to the distance your 
focusing ring is set for, while a smaller aperture will give you much more 
depth of field (DOF).  So if you are using a wide aperture to shoot a room, 
say an f3.5 and you are focused on a chair right in the middle of the room, 
you will likely get that chair in focus and maybe if there is anything else 
about the same distance from the camera, that will be in focus too, but not 
much else.   With a smaller aperture like an f16 you’ll have the majority of 
the room in focus, even if your focal point is the chair in the middle of the 
room.

So to break it down into the Cliff’s Notes version: Smaller aperture = bigger 
number (f16, f18, f22, etc.) = more in focus (DEEP Depth Of Field) = longer 
shutter speeds. Wider aperture = smaller number (f4, f2.8, f1.4) = less in 
focus (SHALLOW Depth of Field) = shorter shutter speeds. 

a p e r t u r e
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Take a quick look at these three images:

At f2.8, the focal area is just on the left side of the image on the tree root.

At f8, the focal area is expanded and more of the root structure is in focus.

At f22, the focus is expanded throughout nearly the entire scene.

a p e r t u r e



Although it may be tough to see in this image, dirt and dust on a lens 
becomes amplified when using small apertures like an f22. Many of these 
spots won't be noticeable at wider apertures.

Why not keep my lens set at f22 all the time?

Well, that’s not always a bad starting point, but there are a few things you 
should know. Full discretion, I used to think that way, too, now I rarely 
shoot at that small of an aperture. Here’s why.

All lenses tend to have a “sweet spot.” This is the area of the lens where the 
focus is extremely sharp. Most of the time these sweet spots are somewhere 
between f8 and f11 or so. It's different for every lens. Even two of the 
exact same lenses may be different. So, you need to do your research and 
experiment until you find the sweet spots on your lens. 

Maybe your spot is an f8. There’s a good chance it is. And there’s a good 
chance that may not be enough depth of field for the scene you are shooting 
and you may want to use an f11 or f14. Or maybe the f8 is perfect, exactly 
what you want. Then fire away!

Another element to think about is how dirty your sensor may be. If you 
start seeing dark areas showing up on your images it may be due to dust 
on your sensor. Even if you don’t change lenses when you’re out in the 
field (avoid this if at all possible), you may have gotten dust on your sensor 
another way. Well, if you do have microscopic dust on your sensor and 
you are using a small aperture like an f18 or f22, there’s a good chance you 
will see those specs on your photo. With a wider aperture the specs may 
disappear all together.

a p e r t u r e
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One more thing to think about. The size of your aperture will dictate how 
fast you are able to shoot a scene. For example, if you are shooting a rocky 
coastline at dusk, you may be able to shoot it at f3.5 and at 1/100 of a second. 
This may be fast enough to capture the scene with a handheld camera but 
your water will look like it is stopped in time (which it essentially is).  

This  may not be the most desirable setting. Instead you would be better off 
having your camera on a tripod and bringing that aperture down to an f8 
or even smaller. By doing this, you will give your water a silky look and it 
will be much more desirable to viewers. If you were to take the shot with an 
aperture around f22 you may actually get a scene where the water doesn’t 
have as nice a quality as it did with a slightly faster shutter speed. So in 
reality, each scene is different and you want to be adept at understanding 
what it is that your aperture does before you go out shooting.

A large aperture like an f2.8 or f4 won't give me much in focus. On the other 
hand a small aperture like an f22 would give the water more movement than 
I would like. For this image I chose an f14 to give me a 1/2 second exposure 
while providing enough detail throughout the image.

a p e r t u r e
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Shutter Speed

We just mentioned it, so let’s dive in to the second part of the exposure 
pyramid, shutter speed. In its most basic terms, shutter speed is the amount 
of time which light is recorded onto your sensor. This can be very fast for 
sports photography like 1/1000 of a second or even faster. It can also be 
very slow like a 20 second exposure for nightscapes.  

If your shutter speed is set to be too fast, your image will be too dark. If 
your shutter speed is too slow, the image will be blown out. So, the key is to 
find the right shutter speed to capture the scene in front of you in the best 
possible light. 

As you can see, the top images were shot too fast (left) and too slow (right). 
The image on the bottom is shot with an appropriate shutter speed.

s h u t t e r  s p e e d
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Most digital cameras have a shutter priority setting. This allows you to set 
your shutter speed to exactly where you want it. When doing this, your 
aperture and ISO will be automatically set by the camera to expose for your 
scene.  And this will work for most photographers most of the time.

Ah, but sometimes you may want to trick the camera into taking an image 
that is faster, slower, darker or lighter than it thinks you should be taking. 
This is when you need to really understand how the exposure pyramid works. 
And this is where you’ll need to be comfortable using manual settings.

So to recap where we are so far, shutter speed will determine the amount of 
time light is recorded onto your sensor. Aperture will determine how much 
light is being let in. So, depending on the size of the opening (aperture), the 
same shutter speeds will produce vastly different results.

Now, depending on how fast or slow your shutter speed is set, will also 
determine whether or not you will need to be using a tripod. There is a basic 
rule of thumb that says you can hand hold a camera as long as your shutter 
speed is at least equal to the focal length of your lens.  For example if you 
are shooting with a 50mm lens, then you would want to be shooting at 1/50 
of a second or faster.  
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I feel inclined to mention this “rule” though I don’t like it. I have a 14mm 
lens that I use all the time. There is no way I would ever be able to take a clear 
image shooting at 1/14 of a second holding that camera without a tripod. You 
may start noticing slight amounts of blur on images when you print them as 
large as I do, and personally, even if I wasn’t printing large format images, 
I would still want to be taking the best images as I could. So here’s my rule 
of thumb for landscape photographers: If you’ve got a tripod, use a tripod. 
If you’ve got a cable release, use the cable release. There’s no guessing there. 
Your images will be tack sharp. Why chance them?

s h u t t e r  s p e e d

At this size, the two images probably look pretty similar. The one on the left 
was shot with the camera on a tripod while the image on the right was shot 
handheld. Both were shot with a 15mm lens at 1/15 of a second.
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Does shutter speed make sense after that?  OK, good. Let’s move on.

When zoomed in a little, you can tell that the hand-held image is simply too 
blurry for any serious print applications. 
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ISO

The final piece of the exposure pyramid is ISO. ISO (International Standards 
Organization) affects the sensitivity of your camera’s sensor to light. The 
lower the sensitivity level, the less sensitive the camera’s sensor is to light. 

Your camera’s ISO settings will probably look something like this: 100, 200, 
400, 800, 1600, 3200, 6400, 12800, etc. Often times there are other stops 
in between (320, 640, 1000, 1250, etc.). What exactly do all these numbers 
mean?  Well they’re essentially telling you how grainy your image is going 
to be. Or, at least that’s how I like to look at it. 

The lower the number of your ISO (100, 200), the more your image will 
look sharp and clear. The higher your ISO, the more grain will be on the 
image itself. I know, I know.  You’re thinking “Shouldn’t I just keep my ISO 
always at 100 then?”

Well, Yes. Except…

The three images above were shot at different ISO settings. From left, ISO 
100, ISO 800 in the middle and ISO 6400 on the right. You can see the level 
of grain increases dramatically from image to image. You can also see that 
the lower the ISO the longer the shutter needs to remain open to yield the 
desired results. 

I s o
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The simple answer is yes. But, that’s not always possible. Sometimes in low 
light settings for example, you may not be able to get a bright enough image 
with the shutter speed and aperture set the way you want it. This is where 
you’ll need to increase the ISO. Sometimes only a hair will do it, sometimes 
it may need to be pushed quite a bit. 

Take night photography for example. If I’m out shooting stars (we’ll get in to 
much more about this in a later chapter), I will want to be shooting at a very 
wide aperture like f2.8. I will also want to be using a relatively fast shutter 
speed like 20 seconds or faster so that I don’t get too much movement in 
the stars themselves. Chances are, wherever I’m shooting these stars is 
very dark around me, and a 20 second shot with a low sensitivity ISO will 
produce a black frame. I may need to kick up my ISO all the way to 3200 or 
so before I get the exposure I want. 

I s o



And that’s how ISO, shutter speed and aperture all work together, and 
why knowing the function of each and how to adjust them becomes vitally 
important for an advanced photographer. 

Most of the time, if you are shooting landscapes you will be able to keep 
that ISO around 100. This is ideal, and probably 97% of the time that’s 
where your ISO will be set. You have your camera on a tripod, you can 
afford a longer exposure if necessary, no problem. However, if you just can’t 
get the shot with the shutter speed and aperture where you need them, then 
your next step is to look at that ISO and start increasing it until you come to 
an exposure that works for you.  Yes, you will be sacrificing a little noise in 
your images in order to achieve the image you’re going after, but sometimes 
that’s all you can do. 

The more you get out and practice setting your ISO, aperture and shutter 
speed, the quicker it will all make sense. Once this clicks, you’re well on 
your way to becoming a great photographer.

I s o
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Metering

Although many landscape photographers never change their metering 
mode, understanding metering is vital for getting the right exposure in 
difficult lighting situations. Back in the days when we shot everything on 
film, it was required that we bring a light meter with us to determine the 
correct exposure when setting up a shot. Today, all DSLRs are equipped 
with an internal light meter that does its best to adjusts aperture and shutter 
speed to match the light of a particular scene. The major flaw with these 
meters however, is they can only measure reflected light, so sometimes, we 
need to compensate…

Internal light meters work well when a scene is evenly lit, but what about 
when it’s not evenly lit, or you have different objects in your scene that are 
lit differently? This is where the different metering modes come into play.   
Nikon and Canon cameras offer at least three different metering modes on 
all of their DSLR cameras. They are:

 • Matrix Metering (Nikon) / Evaluative Metering (Canon) 
 • Center-weighted Metering
 • Spot Metering & Partial Metering

Let’s look into these modes a little to understand when to use each mode.

Matrix / Evaluative Metering
This is your safe spot. Most of the time matrix 
metering will work well for us as landscape 
photographers. In this mode, the camera is 
looking at the entire scene, dividing the frame 
up into zones, and evaluating each zone for 
highlights, shadows, subjects, distances, etc. to 
determine what the correct exposure should be. 
On top of all these factors, it also puts a significant 
amount of weight onto where your focus area is, 
making this the priority for the scene.

m e t e r I n g

Matrix Metering 
(Nikon)

Evaluative Metering 
(Canon)
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Center-Weighted Metering
Like Matrix / Evaluative metering, when we use 
the center-weighted metering mode we are still 
evaluating the entire scene, however we are giving 
the vast majority of weight to the information in 
the center of the frame. This can be helpful if our 
subject is in the middle of the frame and we have 
a sunset off to the side, for example. If you were 
taking portrait shots, this would be a great mode 
to work in.

Spot Metering & Partial Metering
Partial metering is generally found on Canon 
cameras and is very similar to the spot metering 
mode. Some Canon cameras are equipped with 
both Spot metering and Partial metering. The 
difference here, is that Spot metering generally 
evaluates 2.5-3.5% of the viewfinder’s area, where 
as partial metering can be anywhere from 6.5-13% 
depending on the camera model.  For Nikon users, 
the spot metering mode is roughly about 5% of the 
viewfinder area. 

These mode works similarly to center-weighted, 
but instead of being confined to the center of the 
frame, they are determined by the focus area of 
your shot. Wherever your focus is at, that is the only 
area that will be evaluated for light. An example 
of when you might want to use spot metering is if 
you photographing a wild bird in a tree. You would 
want to have your focus on the bird and make sure 
that the bird itself was lit correctly.

m e t e r I n g

Center-Weighted 
Metering (Nikon)

Spot Metering 
(Nikon)

Center-Weighted 
Metering (Canon)

Partial Metering 
(Canon)

Spot Metering 
(Canon)
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The graphics below demonstrate an approximate amount of weight each 
part of a viewfinder has when calculating light in different metering modes.

Matrix / Evaluative
As you see here, the weight is 
distributed throughout the frame, 
however a significant amount is 
attributed to the AF-point on the right.

Center-Weighted
Similar to Matrix / Evaluative, except 
the major area of weight is in the 
center area of the frame.

Partial
Very similar to spot metering, however 
the area of weight is expanded to a 
little more than double what the spot 
metering mode measures.

Spot
The scene will be calculated based on 
the weight from the area just inside the  
highlighted focusing area. 

m e t e r I n g
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Take a look at the examples below. The scene is the same, but the 
metering modes have changed from spot, to center-weighted to matrix/
evaluative metering. The focal point was near the top of the falls. By 
now you should have a pretty good idea of how each of the metering 
modes calculate the lighting of a scene.

Matrix / Evaluative Metering

Center-Weighted MeteringSpot Metering

m e t e r I n g
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Most of the time your viewfinder will display a graphic that looks similar to 
the one above. You can see the reading on this graphic is set to 0. This 
means that no compensation is being done for the image and that the 
camera will process the image normally.

To adjust your exposure compensation, you can move your selector like 
the one above. This one is telling the camera to "stop down" the exposure 
by one full stop. The dots in between the numbers represent 1/3 stops. So 
if you wanted to increase or decrease your exposure in 1/3 stop increments 
you are able to manually adjust this too. Your camera may have 1/3 stop 
increments or 1/2 stop increments.

Exposure Compensation (EC)

Understanding the basics of metering brings us into exposure compensation 
(EC).  Sometimes even with the right metering mode selected, our subject 
may be too dark or too light for our particular liking. When this is the 
case, we can push or pull the exposure. We do this by either increasing or 
decreasing our exposure value (EV).  

Exposure compensation is usually adjustable with 1/3, 1/2 or “full” stops. 
Each full stop adjustment either doubles or halves the amount of light 
coming in. For example, Let’s say we are shooting in aperture mode, and 
our metering says we should shoot the scene at 1/250 of a second. We 
may look at the image and say, “No, too dark. Let’s increase the exposure 
by 1 stop.” By doing this and adjusting our exposure we will be keeping 
our aperture at f8 but making our shutter speed at 1/125 of a second. The 
intent is to fool the camera into shooting the scene with more light than 
the sensor deems necessary.

e x p o s u r e  c o m p e n s a t I o n
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On the contrary, if we were to have the same setup but instead of shooting 
in aperture mode we were shooting in shutter priority, then we would keep 
our shutter speed at 1/250 but our aperture would increase to f5.6.  So, by 
increasing the EV +1, we are doubling the amount of light we are letting 
pass onto the sensor, either by slower shutter speeds or by wider aperture.  
The opposite is true when decreasing the EV -1. 

The problem with exposure compensation is that often times when you are 
increasing or decreasing the amount of light entering the scene, you will 
find by looking at your histogram that your highlights are blown out or 
your shadows have no detail. Ideally your histogram keeps all information 
between the left and right side of the graph. If there is information being 
clipped on the left or right, you are losing detail in your photograph.

e x p o s u r e  c o m p e n s a t I o n

In order to adjust your exposure compensation one 
way or another, look for this icon on your camera 
body. This will allow you to increase or decrease your 
EC by the amount of stops or partial stops you feel is 
right to capture the details of your scene.

The histogram above features a correctly exposed image. There is no 
clipping of information on the left hand side (shadows) or on the right hand 
side (highlights) of the image.
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Bracketing

Hold on to your hats my friends, this is where the magic happens! In my 
opinion, great bracketing is what sets professional landscape shooters 
apart from amateurs. If you’ve been shooting for longer than a week, or 
if you’ve ever tried to shoot a sunset over the ocean, you probably have 
noticed that it’s really tough to not blow out your highlights or get any 
detail in your shadows at all. You may have that round orb of the sun 
in your shot, but there are so many black areas that you can’t figure out 
how to lighten. Bracketing allows you to fix that problem.

Most newer digital SLR cameras have some type of bracketing feature 
built in.  You’ll have to consult with your camera’s manual to figure out 
how to setup bracketing on yours, but here’s the info you need to know 
to get those killer shots. 

Many of those images you see on postcards and in travel magazines and 
art galleries that look so much better than anything you’ve been able 
to capture yet, is not because the photographer that took the shot has 
better gear than you, but rather because he/she is familiar with how to 
successfully bracket their shots. 

Alright, I know I’ve got you on the edge of your seat, so what is 
bracketing? Well, simply put, bracketing is when you are taking multiple 
exposures of a single scene with the intent to combine them later into 
one precise exposure.

b r a c k e t I n g
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The three exposures at the top are bracketed images of the same scene 
taken in 1 stop increments. The bottom image is the result of correctly 
processing the three bracketed images in Photoshop. 
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So it’s like HDR, then?  No. Not really.  HDR is usually a futile attempt to 
bring out highlight and shadow details but there is very  little control over 
the subtlety of the HDR mapping software or in-camera HDR features. 
HDR images generally look fake or pushed. When bracketing images, the 
resulting image tends to look more natural. So if HDR stands for High 
Dynamic Range (which it does), think of bracketing as NDR (Natural 
Dynamic Range). 

OK, sounds good, how do I take bracketed photos then? That’s the easy 
part. Your camera probably has a place to turn on your bracketing and 
it will likely give you the option to choose how many images you want 
in your bracket.  Some cameras are limited at 3 images per bracket while 
some cameras allow up to 9 images. Once you have the amount of images 
set to your liking, you will need to choose how far apart you want your 
exposure values. So, remember with the exposure compensation section 
how we talked about adjusting your images by 1/3, 1/2 or full stops? That’s 
exactly what we’re doing here, only on a bigger scale.

b r a c k e t I n g

The graphic above shows what a 3 bracket sequence setup 
to shoot at 1 stop intervals would look like on your display.

This graphic shows what a 5 bracket sequence setup to 
shoot at 2/3 stop intervals would look like on your display.
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Let’s say you have chosen to have a 5 image bracket, set at 1 stop apart. If 
your exposure meter is set to the “0”, then you will take one shot at -2, -1, 
0, +1, and +2 exposure compensation. Within these five shots you should 
have some very dark images and some very light images. The goal is to take 
these five images and blend them together in Photoshop to create an image 
that produces a natural range of light and detail throughout the frame. I’ll 
dive deeper into the Photoshop aspect of this in the later chapters, but for 
now, just understand how it works…

Each scene is different. Some will require only a 2 image bracket, while 
others might need a series of 5, or even a 9 image bracket. The more you 
play with this, the more you will begin to understand what is possible and 
how far you can push your photography. Understanding bracketing and 
being able to successfully merge bracketed images will easily take your 
photography to another level.

b r a c k e t I n g

This is a 5 bracket image shot at 1 stop intervals and blended in 
Adobe® Photoshop.



White Balance

Before we can truly understand white balance, we have to understand 
color temperature. Color temperature is how we classify visible light. 
These classifications are then measured in Kelvin (K). White light may 
look warmer or cooler depending on the environment, light source and 
time of day. All professional DSLRs have a white balance setting, and all 
have an auto white balance mode, though they are not always the most 
accurate. So, understanding lighting conditions can play a huge part in us 
getting the right color out of our images.

Of course, since we are all shooting in RAW format (we are, right?), 
adjusting our white balance in post production is relatively easy. However, 
getting the right white balance in the camera is more beneficial to the end 
result. Let's dive in and see if we can get a handle on this now.

At some point, you’ve probably taken pictures that have come out too 
yellow or too blue.  This occurs because every light source has its own color 
temperature. Your camera processes colors based on the red, green and 
blue color spectrums that reflect onto the sensor. An image shot at noon 
on a sunny day contains the entire spectrum of light, producing a result 
nearest to natural color. It's at this time that the light is measured between 
5200-6000K or so. 

Cloudy days, porch lights, moonlight, etc. all have different color 
temperatures, so we need to adjust our white balance to compensate. Even 
by using one of our camera’s preset white balance options, we may not get 
an accurate result. On a partly cloudy day for example, the conditions can 
change drastically, thus increasing or decreasing the color temperature of 
our scene. If our scene looks too blueish, we can change our white balance 
by increasing our kelvin, which essentially adds warmth to the scene. 

Take a look at the graphic on the next page for a rough outline of different 
lighting conditions and their relative color temperatures. 

w h I t e  b a L a n c e
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w h I t e  b a L a n c e

Presets
All digital SLR cameras have some presets to help get you the correct white 
balance each time you snap a scene. They do this for compensating for 
the colors that are absent or missing. Let's take a look at some of the most 
common icons and  the approximate kelvin settings associated with each.

Auto
This is a good place to start. Most of the time the 
Auto setting will get you close to the correct light 
temperatures, though it may vary in accuracy.

Daylight
The daylight preset is designed to neutralize colors 
and be most effective when the sun is high in the 
sky, like around midday.

Shade
Use the shade setting under blue skies and when 
you are shooting in the shade. This will add a bit of 
yellow to your image, giving more accurate colors 
in a difficult lighting situation.

Cloudy
Light tends to have a cooler tone in cloudy 
conditions, so this setting adds a bit of warmth to 
overcast scenes.

3000º-7000ºK

5200º-5800ºK

6800-7800ºK

6000º-6800ºK
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In some cameras the Auto icon (          ) may be replaced with    .  Likewise 
the Custom symbol (          ) may be replaced with:      .

Incandescent
If you were shooting indoors under a 60w bulb, 
this would be the setting for you. It will almost 
always give you a more accurate representation 
than shooting in Auto.

Fluorescent
There are a lot of different hues of florescent lights 
and you may have several options on your camera 
for this setting as well. Basically if you are shooting 
indoors and the lights look green, try this setting.

Flash
You would normally use this if you had a flash 
attached to your camera and ready to fire. It is 
close to a daylight setting.

Custom
Set the kelvin temperature yourself with this 
setting. This is a great way to learn about the 
temperature of light and ensure your images are 
spot-on accurate.

2500º-3500ºK

3600º-4000ºK

5200º-6000ºK

2000º-10,000ºK
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Sometimes your presets will look great, and changing the white balance in 
post is always an option if you are shooting in RAW. Eliminating the need 
to correct everything in post is the best option, though. And although it 
may seem like a ton of work, if you adjust your white balance manually 
for about 2 weeks, you will have a much greater sense of the actual color 
temperature of difficult scenes and how to compensate for them in the 
camera. Give it a try!



w h I t e  b a L a n c e

The above image shown with different white balance settings. When I took 
the picture, I shot it at a custom 5850K color temperature. You can see it 
is just slightly warmer than the Daylight setting, and slightly cooler than the 
Cloudy setting. 



F I L t e r s

Filters

I know I spoke a bit about filters in the Essential Gear section of this book, 
but I want to go a little deeper here. 

Truth be told, I’m not a big fan of filters. I know a lot of guys are and there 
are good reasons for it, but me personally, I’m not. If I can capture an 
image without using one, I will. With that said, there are a few that are 
really essential. One thing to keep in mind when purchasing filters is to 
make sure you spend the money on quality filters. Chances are you spent 
a lot of money on your lenses, so what is the point in putting a cheap filter 
in front of it that will likely negate some of the sharpness of your lens? Do 
your research on these, as there are many out there and new ones popping 
up all the time. 

There are two types of filters you’ll find for your camera, the screw on kind  
(like in the image above), and the drop in kind (like the image on the next 
page). Both have their advantages and disadvantages. 



F I L t e r s

The screw on kind are good but can be cumbersome when needing to 
change them if you have a lens hood on. They can be a bear to get off 
too, if they’ve been over tightened. Also, graduated neutral density filters 
don’t work well at all with these screw on type as you can’t really adjust for 
where the horizon is in most landscape shots.

The drop in filters can be great, but they have their drawbacks too. Unlike 
the circular filters they are easy to put in and take off, but they can 
accentuate lens flare if shooting into the sun. This is especially true if you 
have a bulbous wide angle lens and are shooting into the sun. Most of these 
filter systems also hinder using a lens hood, which I’m a big fan of.

Soft edge graduated neutral density (GND) filters like this one can be 
very useful when working with bright skies and darker foregrounds. They 
also lend themselves well to the drop-in filter systems as their rectangular 
format allows for them to be positioned more accurately.
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So what’s the best option, drop in filters or circular? 

I’m not sure there is one. I have both, and use both depending on the 
situation.  I know, more stuff I need, right?! Yeah, sort of. The good news 
is that you don’t need to go out and buy every type of filter on the market. 
In fact, I only use a handful of different filters. Let’s look at them and what 
they do.

Polarizer
Polarizers are great and they are a must have. They can cut down light 
reflections in water and bring more depth to blue skies. For awhile I kept 
a screw on circular polarizer on one of my lenses all the time. And I’m 
glad I did. It is useful in most situations, but more importantly it provides 
protection from drops or slipping on a muddy trail and landing on it.  Yep, 
I did that. Broke the filter, but saved the lens!

Graduated Neutral Density
Another tool for your toolbox, these filters come in handy when you want 
to darken down a portion of your image while keeping the rest of it clear. 
They come in hard edge and soft edge versions. 

The hard edge GND filters would be used when you are shooting a sunset 
over the ocean for example and you don’t have anything above your 
horizon line.  Then you can set the hard edge of the filter to the horizon 
and snap away. This results in an image with less blown highlights and 
clearer details in what would otherwise be a dark foreground.

The soft edge GNDs are a bit more versatile, in my opinion. Very few times 
do I have a flat horizon in my scene. Usually there are rocks, trees, islands 
or other natural objects that rise above the horizon line. These filters can 
be used just to darken a sky while fading out to clear below. They tend to 
give a more natural flow to your image.
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Neutral Density
These are great. I love using neutral density filters. They’re like putting 
sunglasses on your camera lens. By darkening the lens, you are essentially 
tricking the camera into believing it is darker outside than it actually 
is. This is helpful if you want to show movement in water, clouds, fire, 
etc. It’s a great idea to have a bit of a range with ND filters. They come in 
different levels of darkness.  I typically will use a 3 stop, 6 stop or 10 stop.  
Sometimes I’ll even stack them for super dramatic images. 



c o m p o s I t I o n

Composition

There are a lot of “rules” in photography, especially when it comes to 
composition, but don’t think of them necessarily as rules. Think of them as 
guidelines. There are almost always times when breaking these guidelines 
will result in more powerful images. With that said, let’s take a look at 
some of these "rules."

Rule of thirds
This is a good one, and one I adhere to most of the time. Simply put, if 
you were to divide your image into 9 equal sections, with 2 vertical and 2 
horizontal lines creating a grid over your scene. As the rule goes, you want 
to place your most important elements on one of those lines, or where two 
of those lines intersect.  This will create a more visually appealing layout.  

This type of layout works well for us as landscape photographers. We can 
take and move the horizon to either the top line or bottom line instead of 
directly in the middle of the image. Then if we have another element in 
the shot, like a tree or rock or something, we can place that at one of the 
vertical lines. Try it and you'll see your landscapes will start to become 
much more interesting!
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Use Frames
Another way to add interest to your images is by framing the scene 
somehow.  Use natural frames, like caves, or trees and your images won’t 
just look more interesting, but they will likely have more depth as well.

Can you see how the bottom image is so much more dramatic? By stepping 
back a few feet and getting inside a rock cave, we're able to add a natural 
frame and a good amount of depth to the scene.
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Fill the Frame
Sometimes we find ourselves in the midst of an awesome scene, but it's 
just too busy. If your landscape is overrun with too many tree branches or 
rocks, etc., try cropping them out. Find a focal point that is interesting and 
get close to that subject or zoom in. Often times by simply adjusting your 
perspective, you will give your images more of a punch.  

The scene above is nice, but it is lacking a bit of punch. Sometimes simply 
cropping in to the area of interest will help dramatically. The image below is 
focused on the most interesting aspects of the scene above and provides 
a much better overall piece, simply by filling the frame.
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Create Depth 
With landscape photography, it is imperative to create a sense of depth.  
When we have objects in the foreground, middle ground and background, 
we are asking the viewer’s eyes to work their way through a scene. Be careful 
with your placement, though. It’s not hard to overshadow interesting 
backgrounds (mountains, trees, cloud formations etc.) with dominating 
foreground elements.
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Look for Patterns / Symmetry
Patterns in nature are awesome. They can add a sense of depth or take a 
viewer’s eyes to a focal point. A pathway of trees, boulders, sand dunes, etc. 
can be very interesting. When you take and break that monotony a little it 
gets even more interesting. One yellow bird among a sea of brown ones, for 
example is going to look incredible.  

Reflections are equally awesome and provide a symmetrical element to a 
scene. Windless days provide for ideal conditions for lakes to be glassy. 
Glassy conditions are ideal for trees, mountains, clouds or giant rocks to 
reflect in the water, providing fantastic examples of symmetry.
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Vantage Point
I live in Hawaii, where we get literally millions of tourists every year. Many 
of these tourists are photographers looking to capture the beauty of our 
islands. I can’t even count how many times I see people taking photos of 
scenic locations with their tripods up to eye level and snapping away.  This 
works sometimes. For the most part, and especially for subjects that have 
been shot a million times, it's going to be hard for any of those images to 
stand out. 

On the contrary, change your vantage point. I’m always looking at things 
from ground level. Sometimes, I’m laying on my belly to get a shot.  Other 
times I’m climbing trees to shoot downward. Changing your vantage point 
is an easy way to make your images stand out.
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Leading Lines
Leading lines are everywhere. Knowing how to use them is what separates 
the pros from the amateurs. A twisting river takes the eyes on a journey.  
Eyes are drawn to lines like this. Whether they are straight, twisted, or 
otherwise, these lines can direct your viewer to a focal point or clear 
through the frame. Sometimes you may have multiple lines leading to a 
single focal point, if that’s the case, then you’ve struck gold!

Look Around
This isn’t exactly a “rule” but I wanted to emphasize it because it is so 
important. If you find yourself out exploring and looking for something to 
capture, don’t forget to look down, look up, turn around and get low. There 
have been many times when I would have walked right past a scene that I 
really like because I didn’t look around and see something that was right 
below my feet …or above my head!
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Rule of Odds
This is an interesting one. Psychologists have found that when there are an 
odd number of subjects, the viewer tends to focus on the middle one. So, if 
you are out photographing rhinos for example, and there are three in your 
scene, you are probably in the presence of a more visually appealing image 
than if one of those beasts were to suddenly walk away.

The two trees above don't do much by themselves, but look at the image 
below, it's a nice and peaceful image of a family of trees in an idyllic setting.
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The 500 Rule
Sometimes this is called the 600 rule, but personally I don’t like either one. 
You see it a lot, and it's essentially for star photography. The idea is to get 
crisp stars without seeing any motion blur. How it works is you take your 
lens's focal length, so let’s say 20mm on a full frame camera and divide 
500 by that length. So 500/20 = 25. This is telling you that you don’t want 
to take a longer shutter speed than 25 seconds. On a 14mm lens like I use, 
this number goes up to 36 seconds, which I find to be absurd. Zoom in and 
you’ll see plenty of motion in your stars. My go to number is 20. If you can 
get your shot in 20 seconds or less you should be pretty set. You’ll likely 
still see some trailing towards the edges, but for the most part you should 
have nice crisp stars.

A 36 second exposure from a 14mm lens looks fine when zoomed out (top), 
but when zoomed in, you can see significantly more motion on that same 
image (bottom left) compared with a 20 second shot of the same scene 
(bottom right).
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Black & White

Black and white shooting is a different animal than shooting in color.  
There are many considerations that need to be taken into account in order 
to capture really stunning black and white images. The first step is to start 
thinking in black and white. Seeing images without color is difficult at 
first, but when you start to learn what to look for it becomes apparent that 
some scenes lend themselves well to black and white, while some do not. 
Here are some tips that help me when I’m shooting colorless images.
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Contrast
With color images, contrast is often one of those things we want to stay 
away from. It can make images look too busy or cluttered, especially with 
landscape shooting. With black and white photography we actually used 
to add red filters to our cameras when shooting film so that we would 
bring out contrasts! These contrasts help pop the elements in our scene. 

Filters
Although I don’t shoot with filters very often, many of my favorite B&W 
images have been shot with filters. This is because we can add a lot of 
mood and/or contrast with simple filters. A polarizer will darken blue 
skies dramatically, while neutral density filters can enhance images by 
producing longer exposure times and adding a sense of motion. 
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Long Exposures Rock
Lengthening exposures can 
be a game changer with 
monochrome photography. 
Soft water or moving clouds 
can be extra dramatic in 
black and white and can 
help emphasize your focal 
point. Try keeping that 
shutter open as long as 
possible by adding ND 
filters. Sometimes a 3 stop 
or 6 stop is not enough, 
make it 10!



b L a c k  &  w h I t e

Shapes and Forms
In black and white photography, shapes and forms take precedence. They 
become much more noticeable, so pay close attention to them in your 
scene. If you can change your vantage point to emphasize the dynamics of 
the shapes in your composition your image will reap the rewards.

Patterns
Many of us walk right past awesome natural patterns like veins in leaves 
for example. These kind of patterns get amped up exponentially in 
monochrome shooting. Take a closer look at patterns in nature and you 
will find a whole new world of possibilities. 
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Textures
Like patterns, textures get amplified when shooting in black and white. 
When shooting without color, our minds no longer focus on the colors, 
instead allowing textures, shapes and patterns to take precedence. 

Highlights and Shadows
Sometimes I like to darken down an entire scene to focus just on the 
highlights of the composition. I’ll use fast shutter speeds or deep neutral 
density filters to accomplish this. This works well when shooting bridges, 
piers or other architectural elements. 
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Clean Blacks, Pure Whites
In order for your image not to look too muddy, it is a very good idea to 
make sure your piece has deep blacks and pure whites. The key is not 
overexposing or underexposing to get them. This is where dodging and 
burning can be imperative in post processing.

Sometimes it's hard to think in terms of black and white, especially when 
you are staring at all kinds of colors. The scene above had brilliant blues, 
purples, yellows, greens and more. The vibrance of the scene doesn't 
naturally scream monochrome, but the more you shoot in black and white, 
the more you'll start to see things in terms of highlights and shadows. The 
blues of the water were so dark that they almost appeared black. The 
purple of the flower was so bright, it almost felt like it was white. A little 
dodging and burning in Photoshop and the flower pops right off the page!



b L a c k  &  w h I t e

The weather conditions this day at Bryce Canyon drove everyone out of the 
National Park. Except for us. We loved the idea of shooting the canyon as it 
is rarely seen. The flat light and moody clouds became even more dynamic 
once we converted the image to monochrome!

Flat Light
You know those days when you look outside and you see nothing in the 
sky, just flat gray throughout? You’re thinking “No need to go out and 
shoot today, it’s all washed out.” Right? Wrong. These days provide 
excellent opportunities to capture great contrasts, patterns and shapes. So 
next time you think about going back to bed, or curling up on the couch, 
don’t!  Get out and shoot!  You’ve got the tools. 
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Night Photography

Shooting landscapes at night is one of my absolute favorite things to 
do.  The images can be fascinating and ethereal, but they are not easy to 
capture. There are a lot of elements that come in to play when shooting at 
night. Let’s take a look at them so that you too can go out and enjoy the 
magic of capturing the stars!



s h o o t  F o r  t h e  s t a r s !

Shoot for the Stars!

First, here’s what you’ll need: 1) A good sturdy tripod. 2) A shutter release 
(cable release). 3) You’ll want a fast lens, and probably a wide angle one. If 
you have a lens with an aperture of f2.8 or even wider, that’s going to be 
perfect. 

Next, you’ll want to remove yourself from any area with a lot of ambient 
light. Street lights, houses, cars, etc. are the enemy of night shots. So is the 
moon, so make sure you know when and where it rises or if it is going to 
be a new moon or not. Plan to shoot only when the moon is not up in the 
sky. Go somewhere far away from light pollution. Mountains are great, 
if you’re near one as the air is thinner and the skies usually clearer than 
lower elevations. 

Once you’ve found your location, set your lens to manual focus and set 
your focusing ring to infinity (stars are a long way away).  You will need 
to be shooting in manual mode here so that you can set your aperture and 
shutter speed by hand. For your aperture, you’ll want to set it as wide as 
possible. So if you have an f2.8 lens I’d keep it there. If you have something 
faster like an f1.4, then great! Use that! 

Shutter speed is a tricky one. The basic rule of thumb I use is, is to take the 
picture as fast as possible. I do this because stars are in constant motion. 
Even if we don’t notice it with our naked eyes, they are moving. If you are 
exposing for 30-45 seconds or more, the camera will produce star trails 
and motion blur when the image is magnified. We’ll talk about star trails 
in a minute, but right now we want to get the stars as still as possible. My 
go to number is 20 seconds. This is my threshold.  I don’t like to shoot the 
night sky any slower than 20 seconds. I know that when I print images 5 
feet tall I can get my stars with minimal motion in them. Anything longer 
and they start streaking a little too much for my taste. If I can shoot faster 
than 20 seconds I will, but generally 20 seconds is where I live.
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Finally, you’ll want to set the ISO.  This can be tricky too because you don’t 
want to have noise in your photos, but with night shots you absolutely have 
to increase that ISO or you won’t be getting any stars anyway.  Depending 
on my location, I’ll usually start out around ISO 640 and work up. I really 
don’t like going over 800, especially for print, but sometimes I’m increasing 
to ISO 1250. The amount you can push your ISO is really dependent on 
your camera. Some are much better in low light than others. Experiment 
to see where your acceptable limits are. If your final product is only for the 
web and you don’t anticipate printing, then you can go up to ISO 3200, you 
will certainly have many more stars in your shot, but much more noise as 
well. Then again, you probably won’t notice it on Facebook.  ;-)

To recap, when I’m shooting stars I’m usually shooting with an f2.8 or 
wider for 20 seconds or less with an ISO of 800 or less and manually 
focusing my lens to infinity.

Sometimes we have to adjust our settings for ambient light. This image was 
shot before sunrise on a full moon night, so it was brighter than a typical 
night shot. I had to layer 3 exposures to get this piece!



s t a r  t r a I L s

Star Trails

So what about these star trails we mentioned? Well, there are two strategies 
here. The first is to take the settings you used for shooting the stars and 
increase the length of your exposure from 10 minutes to 30 minutes to 8 
hours. You may kill your batteries after 8 hours or so, but you can do it.  

The problem with this method is that these long night exposures tend to 
get filled with noise after just a few minutes. In my opinion, there is a better 
way to capture these images. First, set your camera to the same settings you 
would for a single still image of the stars. Next, use your shutter release to 
continuously snap frames at those settings. That's it! Over the course of 45 
minutes or so you should have over 120 photos or so you can work with.

Then you can take these and open them in a single file as layers in 
Photoshop. Set the blending mode to “Lighten” on all the layers EXCEPT 
the bottom one. That one should be left at “Normal.” What this will do 
is keep visible just the lightest areas from all the photos whose blending 
mode is on “Lighten”. Since the images were taken in sequential order 
without any breaks in between you should get a pretty remarkable star 
trail image, like the one above!
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Shooting the Moon

The moon is a bit different as it gives off a ton of light itself. All the strategies 
above are thrown out the window when shooting the moon.  In fact, when 
I photograph the moon I try to use a long telephoto lens so I can get as 
much of it in the frame as possible. 

First and foremost, if you want your moon in focus, make sure you have 
your lens set to manual focus and set the focusing ring to infinity. Next,  
you will want to adjust your camera settings. These will vary a little based 
on the amount of light around you, but here’s where I usually start: I like 
to keep my ISO down, so I’m usually between 100 and 400 or so. This will 
keep the noise on my images to a minimum. Next, I’ll set my aperture 
between f8 and f11. Then I'll adjust my shutter speed. The moon is moving 
faster than you think, and because of that, you’ll want to shoot with a 
quick shutter speed.  Normally I like to start around 1/125th of a second 
at ISO 100 and compensate from there. If I need a brighter exposure I may 
jump to an ISO of 200 and around 1/250th of a second or so. These settings 
may need some fine tuning depending on how bright the sky is around 
you, any cloud cover you have and other ambient light.

You’ve got a lot of tools in your pocket now, and the night sky is vast and 
waiting. Go get it!





s o F t w a r e  /  L I g h t r o o m

Software

There are a ton of programs (both file management and image processing 
software) out there for photographers. I’m not going to go into all of 
them, but I am going to touch mostly on the big two, Adobe Lightroom 
and Adobe Photoshop. There are other programs that offer similar sets 
of tools but these are the two I use most often and it seems about 95% of 
photographers do as well.  So let’s dig in.

Adobe Lightroom, for those of you who haven’t used it, is 
a photo management and editing software. It allows you 
to import photos and acts as an interface where you can 
do moderate post processing. There are other programs 
that are similar, but Lightroom is the most popular and 
the  one I use most, so let’s talk a little about that.

Adobe Lightroom®
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Lightroom is one half of the Adobe Photography bundle. This bundle is a 
monthly subscription from Adobe that, at the time of this writing is $9.95 
per month. I’m not a huge fan of subscription services, but this one is a 
pretty good deal. It gives you access to the latest editions of both programs 
along with all updates and support as long as you’re paying. 

I use Lightroom every time I import photos. The program acts as a file 
management software that allows you to easily view all your images, 
consolidate them into folders of your choosing, setup collections, tag 
images, rate images, edit and delete images. It would literally take me twice 
as many pages as this book has to go over all the aspects of Lightroom, but 
I am going to give you a basic feel of the tools in it that I use, and how my 
Lightroom processing usually progresses.

Step 1: Importing
When importing files, I make sure I use the “Copy as DNG” setting at 
the top of the import area.  What this does is it converts your file from 
a .CR2, .RAW, .NEF or whatever type of RAW file you are using into a 
.DNG file. Why would I do this? Well, the .DNG file is an Adobe native 
file format which compresses some of the information and reduces the 
size of the overall file. This is super helpful later on when you have tens of 
thousands of pics on your hard drive. These files can always be converted 
to something else later, like TIFF files but while in Lightroom, I like them 
to be in .DNG format.
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What this does is help me later on. If 
I were to be looking for images from 
Bend I could simply type “Bend” in 
the Lightroom search area and all the 
images that I’ve previously tagged with 
“Bend” will be displayed. Use a comma 
to separate keywords.

Then under “Destination” I like to keep 
all my images in one location. So I have 
a main folder called “Photography” 
on my hard drive, then I subdivide it 
by year and then again by location. 
For example right now I have a folder 
called 2016 inside my Photography 
folder. Inside that I have a folder called 
“Canada”, another called “Southwest”, 
one called “Oahu”, one called “Maui” 

On the right hand side of the import 
area Lightroom provides a multitude of 
different options. Under File Handling, 
I use Build Previews as “Minimal”, and 
underneath that I select “Don’t Import 
Suspected Duplicates.” The rest in this 
section I leave open.

Under “Apply During Import” I’ve 
setup a Metadata file that adds a bunch 
of information to each file. It’s a good 
idea to set one of these up. I also add 
keywords to the entire batch. For 
example if the photoshoot was in Bend, 
OR I’ll write something like: “Bend, 
Oregon, Landscapes, Mike Neubauer, 
neubauer.net, Sunset, Mountains,” etc.96
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and another called “Big Island”. These are the locations where I’ve gone 
shooting in 2016.  If I went to another area I’d create another Subfolder 
under 2016 for the area that I traveled to. There is no right or wrong way to 
setup your folders, do it however is easiest for you, this is just what works 
for me. When all that information is complete, I’ll hit the “Import” button.

Step 2: Sorting
If you’ve never used Lightroom before, it’s probably a good idea to get 
a book on this application to get familiar. Scott Kelby writes a really 
comprehensive version that’s simple to understand. It’s also a good idea 
to start learning the keyboard shortcuts. This will save you a ton of time 
in the future, plus many of the keyboard shortcuts in Lightroom have the 
same functions in Photoshop.  If you get used to using them from early on, 
you will cut down on your processing times dramatically.

Moving on, so I’m assuming you have a basic understanding of Lightroom 
by now. If not, try to bear with me. In the Library mode I’ll usually go 
through the images I just imported in Loupe view (keyboard shortcut: E). 
I’ll make sure my Navigator (located in the upper left section of Lightroom) 
is set to “FIT” so I can see the entire image in my viewing area. 
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Next, I select the first image in my film strip and hit the “L” key on the 
keyboard twice to dim the lights completely.  This brings the full image 
into view with a black background. From here I quickly go through each, 
by marking the ones I like with a number 1-5 on the keyboard. This will 
star the images with 1 to 5 stars depending on how much I like them. 
Because I go very quickly through the images though, I usually just use 
the “1” key to mark ones I like and the “x” key to mark images to discard. 
You’ll see the icons in the film strip get marked with either one star or they 
will be grayed out if they are to be discarded.  Most images get grayed out.

After I have gone through each image once, I’ll go through the remaining 
images a second time, this time after I’ve already removed all the grayed 
out images from my library. This will usually get me to a point where I have 
only the images I need in my folder. From there it’s on to the processing.

Along the bottom portion of the Lightroom window is the camera roll. I 
go through these images one by one very quickly and mark them with a 
number (1-5 depending on how much I like them), or an "x" if I don't. When 
I put a number on the image a star shows up under the thumbnail. When I 
mark it with an "x", the image becomes grayed out, making it easier for me 
to go back and edit the ones I like later on.
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Step 3: Processing
Lightroom can be a very adequate program to do all your processing 
in, but I prefer to do most of the heavy lifting in Photoshop. This allows 
me to target a wider range of areas, and dig into images in a way I can't 
in Lightroom. With that being said, I do perform some basic editing in 
Lightroom for every picture. Here's what I do:

In the Develop module, if you look at the right hand side of the screen, 
you’ll see all kinds of sliders and check boxes. My general process starts by 
heading about 3/4 of the way down to the “Lens Corrections” section.  I’ll 
then tick the “Remove Chromatic Aberration” box and the “Enable Profile 
Corrections” box. You should see your camera and lens information 
popup in the Lens Profile section under “Enable Profile Corrections”. If 
you don’t, click on the Make, Model or Profile dropdown menus and find 
your camera and lens. If you don’t see your gear on there, write to Adobe.

Lightroom does a great job with removing chromatic aberration which is 
essentially the color fringes that show up on some images, usually in high 
contrast areas. Making sure these two check boxes are marked in the 
"Lens Corrections" panel is always my first starting point in Lightroom.
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Then, if you scroll back up on the right 
side until you see “Basic,” I’ll adjust the 
Highlights and Shadows. Usually I’ll 
drop the Highlights to no more than 
-50 and increase the Shadow area to no 
more than +50.  What this does is it tries 
to bring back information that may have 
been blown out in the white areas and 
under exposed in the darks. 

Below the Highlights and Shadows area 
I may add just a couple points on the 
Vibrance and Saturation sliders, but 
usually no more than about 5 on each.  
It’s very easy to go overboard here and if 
you do you will seriously ruin your image.  Be conservative!

If I need to adjust the white balance I can do that too in this box by 
adjusting the Temp and Tint. If not, I’ll move on. Believe it or not, this is 
usually all I do in Lightroom. Unless I want to crop the image a certain 
way, then I’ll do that here by clicking on the first icon underneath the 
histogram. Otherwise it’s on to Photoshop!

When I'm ready to bring the image into Photoshop, I'll control click (Mac) 
or right click on the thumbnail, choose "Edit In" and "Edit In Photoshop..."
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Multiple Exposures
We talked about bracketing in an earlier section. However, let’s say I didn’t 
get a bracketed shot but I really could use another exposure of an image. 
Maybe the one I got was a little too light. If this is the case, I could take 
the image in Lightroom and make a Virtual Copy of it (right click on 
the film strip image and select Create Virtual Copy). Then I’d go to the 
Basic panel on the right hand side in the Develop module and adjust the 
exposure down a full stop (-1.00) or so. While not the ideal way of creating 
a bracketed image, this gives you a second exposure which may give you 
the darks you need to work with along with the original file in Photoshop. 
And if you need one that’s lighter than your original you can do the same 
thing, create a virtual copy and increase the exposure a full stop. Now you 
have a virtual 3 image bracket to work with in Photoshop.  

There are occasions when I may want to adjust the colors a little more here 
or the brightness or darkness of the scene.  If this is the case and I adjust 
the settings under the “Tone Curve” panel or the “HSL” panel. I try to be 
very conservative with this as well. Nothing ever gets pushed or pulled 
more than 20 percent in either direction. 

After creating the virtual copies, simply take one image and drop the 
exposure one stop, and take the second and increase it a full stop.
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Layer Masks
My files can get pretty big because I tend to use a lot of layers. I also save 
my Photoshop files as TIFF files as they keep my layers intact and don’t 
remove any information.  This is great if I want to reprocess an image later. 
I assume you are already familiar with layers in Photoshop, but you may 
not be familiar with layer masks. 

This program is huge. So huge that if I were to write 
about all the things you could do in Photoshop the book 
would look like the entire set of Encyclopedia Brittanica 
(dating myself again, I know, but you older folks will get 
my reference). I’m going to touch on my basic workflow 

Adobe Photoshop®

and some of my most common techniques here. This is by no means all 
encompassing, but it does serve as a good start and should give you a good 
idea of some of the tools and techniques I use most often.



p h o t o s h o p :  L a y e r  m a s k s

Now, if you look at the bottom of your layers palette (Based on the current 
Photoshop CC 2017) you have several different icons. From the left, the 
first one links layers, the second one adds a layer style, the third one is your 
layer mask, the fourth creates an adjustment layer, the fifth one creates a 
group (folder), the sixth one creates a new blank layer and the last one is 
the trash, which is used to delete layers. 

Let’s assume you have three images you took as a three shot bracket of a 
particular scene. One at a stop below, one at a stop above and one right 
at your camera’s recommended exposure settings. You open each of 
those three shots as a separate layer in Photoshop. To do this, while in 
Lightroom, select the three bracketed images, right click/control click, 
choose "Edit In" and then select "Open as Layers in Photoshop."  Using this 
method, Photoshop will render each Lightroom image as as separate layer 
within a single file. From here, I generally will drag layers to position the 
darkest layer on top followed by the second darkest and the lightest at the 
bottom of the stack.

You can see the three images I'm working with in the layers palette with the 
top layer being the darkest followed by the second darkest and the lightest.
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The three layers are stacked on top of each other with the darkest layer 
on the top. You can see the image is pretty dark right now, but as we start 
painting away using layer masks it will lighten up dramatically.

These are the different icons at the bottom of the layers palette in Photoshop 
and the function associated with each.

Right now your file should look too dark. This is because we have our 
darkest layer on top of the other layers in our palette. Since it is on top 
and 100% opaque, it has priority over the layers below it. However, with 
layer masks, we can select portions of a particular layer and change the 
transparency from 100% to whatever we feel looks right, 90%, 73%, 31% 
etc. The easiest way to do this is with the paintbrush tool. Alright, let's take 
a look at how we do this.
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If we have the darkest layer 
selected, and we click the layer 
mask icon at the bottom of the 
palette, you will see  a link symbol 
and a blank white canvas appear 
next to the thumbnail of the 
layer. That white canvas is telling 
you that the entire dark layer is 
opaque. Unless of course you 
changed your layer’s opacity, then 
it’s not, but assuming you didn’t, 
then you should see no change to 
the actual image... yet.

On the left hand side of the screen are your tools. Select the paint brush tool 
(keyboard shortcut: B). You can adjust the size and shape of your brush if 
you like. This can be done on the top pane just above your image. If you 
look above your brushes there should be a horizontal bar where you see the 
paintbrush icon on the far left. Next to it you may see a circular gradient 
or another shape.  This is your paint brush’s shape.  I like using this soft 
gradient brush. You can click on the gradient to adjust the size of it or to 
change the hardness or to choose a different brush you like altogether.
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Next along that horizontal bar, look for where it says “opacity.” I generally 
start off by taking that down to 25% or so.  Keep the flow at 100%.

on the left side of Photoshop. Here you will see two squares. When you 
create a layer mask those squares by default turn to black (top) and white 
(bottom). The top color is the active (or foreground) color. The bottom 
color is the background color. If the foreground color is not black already, 
click on the top square and change it to black.

Make sure your brush 
color is black (it should 
be by default). To know 
for sure, look at the 
bottom of the toolbar 

Once the brush tool and 
appropriate (foreground or 
background) color is selected, 
the next thing to do is select the 
layer mask. In this case select 
the layer mask (white canvas) 
of the darkest layer (top image). 
Selecting the layer mask ensures 
you are editing the mask and not 
the actual image. If the actual 
layer is selected, you will be 
altering the actual pixels in the 
image. Once the mask is selected, 
start painting your image. You 
will see that you are basically 
peeling away bits of that image to 

On this graphic you can see I am 
working on the layer mask of the 
middle layer. Having already masked 
out the darkest layer, I move to the 
layer below. I keep this process going 
for as many layers as I have.
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reveal the layer below. The more you paint, the more of the mask is peeled 
away. The mask icon in the layers palette will reflect the painting that you 
are doing on the image.

If you happen to go too far in your mask painting, don't worry. You can 
easily fix your changes. The X button on your keyboard allows you to 
switch foreground and background colors. When you press the "X" the 
black will become the background color while the white will now come to 
the top and be the foreground color. 

If you painted too much of the mask away, simply paint with the white 
brush to add opacity back to the layer you are painting on. The white color 
will act like an eraser, removing the black that you painted on your mask. 
It is a good idea to continue to use a low opacity with the white, so you can 
subtlely add back in the layer that you had previously painted away.

Once you finish on the dark layer move on to the layer below that, and 
finally to the layer below that one. If there are only three layers it won't 
take you too long. However, if you've managed to shoot a 9 image bracket, 
you may be spending quite a while just with these layer masks!

I use this technique A LOT. Every bracketed shot gets altered like this 
before I do anything else. I peel away the parts of the layer I want to 
lighten. Then I go down to the layer below that and do the same thing. 
I create a layer mask and start peeling away areas that I’d like to be even 
lighter. This can get very time consuming and intricate if you are as detail 
oriented as I am.  You’ll likely find yourself zooming in a lot, changing the 
size, shape and opacity of your brush to get your image to look just right. 

Masks can be used for much more than bracketing too. You can use them 
to get rid of people walking through your image, an odd bird in your scene 
or any number of things that you may want to remove from your frame. 
The possibilities are endless!

p h o t o s h o p :  L a y e r  m a s k s
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With the layers masked and blended the tones look much better on this 
image. It's not done yet, but it is on its way. The next step is to add a few 
adjustment layers to really make this image pop!

These layer masks are not just for image layers either. They are used on 
adjustment layers and layer groups as well. Masks are super powerful in 
Photoshop, so get used to using them. Your images will certainly thank 
you for it later!

p h o t o s h o p :  L a y e r  m a s k s
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Luminosity Masks
Sometimes it’s too difficult to just take the paint brush tool and peel away 
at the light area without also getting some of the information in the dark 
area as well. To get a lot more accurate, we can use these luminosity masks.  

We may be going a little deep here, especially if you were new to Photoshop 
before this. Luminosity masks are a great way of refining a selection. With 
luminosity masks we are able to specifically target a certain range of tones 
in our images. Whereas with layer masks we used broad brush strokes, 
with luminosity masks we are creating detailed selections to work with.

Luminosity masks allow for refined selections based on color or tones in 
an image or scene. When making luminosity selections we can select light, 
mid or dark tonal selections in the image via luminosity masks. We can 
also do the same thing for specific color tones.

p h o t o s h o p :  L u m I n o s I t y  m a s k s



If we are creating "light" luminosity masks, the pixels that are 100% 
luminous, or show up as pure white will be completely unaffected by the 
mask. Those pixels which are 0% luminous, or show up as pure black will 
be completely masked off. Everything else in between will be partially 
masked. The lighter the gray tone the less it will be affected by the mask. 

Our first light luminosity mask will look a lot like a simple grayscale 
version of the image we are working on. 50% gray tone in this mask will 
be 50% selected.

When we create the second light luminosity mask, it will look a bit 
darker. This is because now we are halving the amount of tone we are 
selecting. In this mask our 50% gray tone is only 25% selected. Our 
third light luminosity mask will appear darker still as our 50% gray tone 
is now only 12.5% selected. So each time we are creating a new light 
luminosity mask we are simply selecting less and less tonal range. By 
the time we get to the third, fourth, fifth masks, only the very brightest 
tones will be selected in our masks. Let's take a look at a few examples.

The above tone gradient is used to demonstrate the range of tones in 
an image from lights to darks. The middle square represents 50% gray. 
When we create luminosity masks we are essentially creating masks 
based off a grayscale representation of the image we are working on. 
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In our first luminosity mask, we have what appears to be a grayscale 
version of our working image. Our 50% gray color is 50% masked off.

Our second luminosity mask is noticeably darker. Here we are masking 
only 50% of our 50% gray tones, (25% of our 50% gray).
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The third light luminosity mask is only masking off 12.5% of our 50% 
gray tones.

In this fourth light luminosity mask we are only masking off 6.25% of our 
50% gray tones. In this mask we are selecting only the brightest of the 
tones in our image. We can keep going too, lights 5, 6, 7, etc. will keep 
getting darker, until eventually the mask is completely black (transparent) 
and nothing is actually masked off. 
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Creating dark and midtone luminosity masks works on the same principles 
as these light luminosity masks.

Luminosity selections can be made by hand or generated via plug-ins. I'm 
going to show you how to manually make these advanced selections in 
the pages that follow. Beware, understanding these complex selections do 
take a bit of time to learn. In my opinion, it's a good idea to learn how to 
create them and how they work instead of relying on a plug-in or creating 
an action for it. 

Like any mask in Photoshop, luminosity selections can be manipulated 
to arrive at a desired effect. These selections differ from other selections 
in Photoshop in that they are precisely targeting a specific range of tones 
throughout an image allowing for a more blended look in the adjustments 
you are making. This is why they can be so powerful and truly are so 
necessary to understand. If you are still with me and I haven't scared you 
off completely, let's now dive in...

In this example I am using two layers. They are both the same image, 
though one is a full stop underexposed. This is the layer I want to be the 
top layer in Photoshop. 

First, create a layer mask on 
the top (underexposed) layer. 
Then, turn off that layer. We 
turn off that layer because we 
want to create our luminosity 
masks based on the lights and 
darks of the more accurately 
exposed layer.

Now go to your channels 
palette (to the right of your 
layers palette). The top layer 
should be called RGB or if 
you are working in CMYK 

After creating the layer mask on the dark 
layer, I clicked on the eyeball icon next 
to the layer to turn off the visibility of that 
layer.     
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format it will be called CMYK. 
Immediately below this layer 
are individual channels for the 
colors Red, Green and Blue (or 
Cyan, Magenta, Yellow and 
Black if working in CMYK). 
For the purpose of this book 
we're going to look at creating 
luminosity masks off of the 
overall lights and darks of the 
entire RGB image. However, 
sometimes you may want to 
create luminosity masks off 
of individual color channels 
when you need to target a very 

In the channels palette, the top layer is 
a combination of the Red, Green and 
Blue layers below it. It is by default called 
"RGB".    

exacting range of color tones.

On that top RGB layer, hold down the command key (Mac) or control key 
(Windows) and click on the layer's thumbnail. This will bring up a bunch 
of ‘marching ants’ around the light tones. 

When we hold down the command key (Mac) and click on the RGB or 
CMYK layer in our channels palette, these 'marching ants' show up to 
select only the brightest areas of the image.  
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On the bottom of that panel is a mask icon. Click on it.  
You’ve just created a luminosity mask called “Alpha 1”. I 
like to rename that layer "Lights 1," or "Brights 1" so I know 
where I'm at if I decide to make several light and dark 
luminosity masks.

When you click on the Alpha 1 layer you’ll notice that it 
is in black and white. If there are still a lot of white areas,  
we'll need to create more bright luminosity masks. To do 
this, we will want to now be on the "Brights 1" layer. Our 
marching ants should still be selected, but now instead of 
holding down command and clicking the layer thumbnail, 
we'll want to hold down command, option and shift all at 
the same time (I believe that is the control, alt and shift 
keys on a PC). Then we can click on the "Brights 1" layer 
thumbnail.  You'll see our 'marching ants' have been refined 
to select a brighter range of tones. Now we can click on the 
mask icon at the bottom of the palette again. This will create 
another luminosity mask to go along with this more refined 
selection we created. We can then double click on the layer 
itself and change the name to "Brights 2". 
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After creating the bright channel masks, I'll create the dark masks in a 
similar way.

To select your dark tones, go back and click on your ‘RGB’ layer. Hold down 
the command key and click on the layer. Now hold down the command, 
shift and "I" keys (or control, shift and 'I" keys on PC) to select the inverse 
tones on the layer. Click on the mask icon at the bottom of the palette.  This 
will create an alpha mask that has your dark colors selected. You'll know 
it worked when you click on the alpha channel you just created and all 
the dark colors are now bright, while all the light colors are now dark. Go 
ahead and rename this layer "Darks 1". 

To refine this layer further, we'll go through the same steps as we used with 
the Brights channels. Click on  the "Darks 1" layer thumbnail, then hold 
down command, option and shift and click on the layer thumbnail again 
to refine your 'marching ants'. Finally, click on the layer mask icon at the 
bottom of the palette. This will create your second darks channel.

With the "Brights 2" layer selected, you can see now we have refined our 
selection to a much smaller range of tones. Sometimes we'll refine this 
selection of brights a few more times before we are dialed into just the 
areas we want to focus on adjusting. 116
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After you've created your range of brights and darks, you may also want to 
create mid-tone luminosity masks. 

Mid-tone luminosity masks are great for adding subtle contrast to your 
image without losing detail in your light or dark tones. Making these 
masks requires that you already have your light and dark masks created.

To begin, while still in your channels panel go to Select > All. This will 
put your marching ants around the entire image. Now, hold down the 
command and option keys (Mac) and click on the thumbnail of your 
"Brights 1" layer. This will subtract the areas selected in that mask. Next, 
hold down the command and option keys again and click on the thumbnail 
associated with the "Darks 1" layer. Don't be afraid if a Photoshop warning 
dialog box pops up. This is pretty common. Just ignore it by pressing OK. 

You can see in this screenshot that I have created several dark alpha 
channels as well as bright ones. This gives me a good range for the areas 
of the image I want to target most precisely.

Like we did with the light channels, you may have to go through this 
process several times in order to refine your masks to target just the tonal 
range you require.
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Now click on the layer mask at the bottom of the panel. Boom, you just 
created your "Mids 1" mask. 

To focus on the midtone selection further, simply hold down the command, 
option and shift keys and then click on the "Mids 1" thumbnail. You may 
get that silly dialog box again. Again, ignore it. Hit OK, then click the layer 
mask icon again. Now you should have "Mids 2." Repeat this process to 
create more mid-tone luminosity masks.

Don't be too concerned if you see this dialog box pop up when trying to 
create your mid-tone luminosity masks. Just hit OK and keep going.

Mid-tone masks look a little funky, but they are a great way to adjust the 
contrast in your image without clipping your lights or dark tones.
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Back in the layers palette, I've turned on my underexposed layer and 
have the layer mask selected. You can see the 'marching ants' from the 
luminosity mask I selected are still visible. 

For this particular image, I liked what I was seeing on the "Brights 3" mask. 
So I clicked on the layer thumbnail for the "Brights 3" channel. This brings 
up the 'marching ants'. Then I can leave my channels panel and go back to 
my layers panel. I turn back on the visibility to the underexposed layer I 
had turned off previously and click on the layer mask I already created on 
this layer. The 'marching ants' should still be visible. 

There are several ways to now adjust this underexposed layer. I prefer 
to paint in the areas I'd like to focus on. To do this, I'll hold down the 
command and "H" keys to hide my 'marching ants' (control and "H" for 
PC). They are still selected, but now they are no longer visible. Now I'll take 
my paintbrush tool and just like we did in the layer masks section, I'll start 
painting away on the layer mask. 

When I finish with the areas I'm focusing on with the "Brights 3" selection, 
I'll go back to my channel masks and select another luminosity mask. 
Maybe this time I'll use "Darks 1". Then I'll go back to the layer and paint 
away the areas I want to hide from that particular mask. I go through this 
process for each layer in my scene. By the end, my masks can look pretty 
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crazy, but I will have all the tones just where I want them to move on to 
the next form of processing.

If this sounds too intense, try to be patient. The more you can work 
with luminosity selections and masks, the more you will understand it. 
Practice, young Jedi. You will get it!

If this is really not what you want to be wrapping your head around, there 
is good news. There are many plugins and actions for Photoshop that you 
can download that create luminosity masks automatically for you. If you 
do a quick Google search, I'm sure you can find a bunch of them. A few that 
I recommend are through some very talented landscape photographers.

Check out Jimmy McIntyre (ShutterEvolve.com), or Tony Kuyper 
(Goodlight.us) for some great downloadable actions. You can also look 
into Sean Bagshaw (OutdoorExposurePhoto.com) and/or his buddy Chip 
Phillips (ChipPhillipsPhotography.com). Both have great video tutorials 
available for purchase through their sites. These actions and plugins make 
creating luminosity masks super easy and takes the redundancy out of 
trying to create them on your own. 

In the layer mask, I've painted away at the underexposed layer to reveal 
the lighter tones from the layer below.
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Then again, if you want to create them on your own, by all means! You can 
easily make your own actions too, if you so desire.  

A couple things to note with regards to these luminosity masks, though. 
One is that as you make changes to your main image, your channel masks 
may no longer be accurate. Deleting and recreating luminosity masks 
might be necessary. This is where your own actions or a simple plugin for 
Photoshop really saves a ton of time. 

Also, sometimes you don’t just want to highlight bright or dark areas. 
Sometimes you may want to create luminosity masks based off the red 
channel, blue channel or green channel. The process to doing this is the 
same as described earlier, though instead of using the RGB layer as your 
base, you'll want to use the respective color channel that you wish to target. 
Not all images are the same but the more you work with these, the more 
you’ll be able understand which channels you’ll need to select in order to 
properly work your layer masks. 

If you’re not fully confused by now, I don’t know what else to say.  That 
should’ve done you in. If you are completely lost, start slow. If I didn’t 
explain something very well (more than a remote possibility, I’ll admit), try 
to look up some of these techniques online. There’s a myriad of resources 
out there that probably do a better job than I do of explaining these things!
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Adjustment Layers
Now that you’ve got masks down, let’s get to adjustment layers. These are 
tremendously powerful tools. There are many options here, but I’m going 
to just touch on a couple of them. The first is curves. Make sure you are 
working on the top layer in your image, then click on the adjustment layers 
icon on the bottom of your layers panel, you will see almost 20 different 
options. Scroll down to the curves one and click on it. 

This will bring up a curves 
dialog box, like this one 
on the right. You will see a 
histogram type graph with 
a solid line going from the 
bottom left to the upper right 
corner. When you adjust your 
curves, you are adjusting the 
tones in your image. When 
you click anywhere on that 
line you create an anchor 
point. If your anchor point is 
in the middle then you will 
be adjusting the midtones 
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of the image. Creating an 
anchor point to the upper 
right will adjust more 
of the highlights, while 
creating an anchor point at 
the bottom left will adjust 
the shadows of the image. 
You’ll also notice when 
you click on an anchor 
point and drag it, that you 
will be adjusting the tone 
in an image by increasing 
contrast in one area and 
decreasing it in another. It is 
important to note that even 
slight adjustments here can make a huge difference on your image.

One more thing to note is that instead of adjusting the tone of all the 
colors of the image (RGB for example), you can click on that drop down 
menu that says RGB or CMYK and adjust the individual channels. So if 
you just want to adjust the red channel you can do that.  This gets pretty 
intense and it's easy to go overboard, so be careful.

Finally, before you close the window, you will notice a set of icons along 
the bottom of the dialog box. The first icon changes the effects of the 
curves adjustment. If you click on that icon, you will only be applying 
the effects of the curves adjustment layer to the layer directly below it. 
If you press the icon again, you will be adjusting all the layers below the 
adjustment layer. This can be super helpful. It also goes to show that it is 
very important to be aware of the hierarchy of your layers.

Clicking on this icon will clip the adjustment layer just to the layer you are 
working on, while having it deselected means the adjustment applies to 
your entire workflow.
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The rest of the adjustment layers work similarly to the curves one.  You 
can adjust as you please in a dialog box, and then use a mask on the 
adjustment layer to peel away part of that effect. Although I rarely use 
most of them, some like the Selective Color, Hue/Saturation and Photo 
Filter I do use quite a bit. Play around, these adjustment layers provide 
amazing options for your images!

Once you close the 
dialog box you’ll see the 
adjustment layer above 
the layer you were just 
working on. You’ll also 
see it already has an 
opaque mask on it. Let’s 
say your adjustment was 
great in one section of 
your image but a little 
too much in another, 
just make sure you click 
on the layer mask of the 
adjustment layer and 
paint away the areas that 
are too strong.

You can see above "Layer 1" is an 
adjustment layer with a curves layer mask.

So far I have 5 adjustment layers, but this piece is starting to look good!

p h o t o s h o p :  a d j u s t m e n t  L a y e r s

124



The Dodge and Burn Tools 
are located in the main 
toolbar on the left side of 
Photoshop. By pressing 
and holding the Dodge  
Tool graphic, a submenu 
pulls up additional options.

p h o t o s h o p :  d o d g e  &  b u r n

125

Dodge & Burn
These are two essential tools for lightening and darkening parts of your 
image in Photoshop. Dodging allows you to hold back light from a selected 
area of your image, essentially lightening that area of your photograph. 
Meanwhile, burning lets you overexpose the area you are working with, 
in turn darkening it.

As with most Photoshop techniques, I recommend never working on the 
original image itself. Instead make a stamp (Shift+Ctrl+Alt+E [Windows] 
or Shift+Command+Option+E [Mac]) of the visible layers before applying 
dodge or burn. 



These two tools, located in the toolbar on the left side of Photoshop, work 
similarly to a brush tool, where you will need to set the brush shape, 
hardness and opacity. This can be done on the top navigation bar in 
Photoshop. As you move to the right on the nav bar, you’ll see a “Range” 
drop down box. This allows you to select the highlights, midtones or 
shadows to focus your dodging and burning to even tighter areas.

You also have the option to “Protect Tones.” I tend to leave this box checked 
as it will tend to minimize any clipping in your light or dark areas and also 
protect the colors from shifting hues.

When you’ve got your brush setup 
the way you want and your range 
protected, you’re ready to start 
dodging and burning. You may 
need to go over areas several times 
to see an effect, but be cautious as 
too much dodging and burning 
can get you in trouble real quick 
with your details.

The top nav bar in Photoshop lets you really dial in how you want to use 
your dodge and Burn tools.

126

p h o t o s h o p :  d o d g e  &  b u r n



127

When you look closely at the two images here, you can see the bottom 
one is much more dramatic as I've dodged the highlight areas and burned 
the shadows for a more contrasting picture. 

As with many other Photoshop techniques, dodging and burning can be 
paired with luminosity masks, blending modes (we'll cover this more later 
on), or even adjustment layers in order to achieve your desired results. 
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Removing Unwanted Objects
We’ve all been there. You have the perfect sunset and somebody walks 
right in front of your camera. Or the scene is gorgeous… except for some 
large pole or sign or boat or whatever that you really wish wasn’t there. The 
good news is that for the most part, removing unwanted objects is fairly 
simple. The bad news is, there’s a million different ways to do this and it’s 
not always clear which is the best way. 

The two I use most often are the Clone Stamp and the Healing Brush. 
Before beginning with either one, I always make adjustments on a copy 

of the layer I want 
to target and not the 
original. 

The original (inset) image shows a structure that was distracting from 
the overall scene. There are several ways to remove objects like this in 
Photoshop. Here are my favorites.
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The Clone Stamp is certainly a more powerful tool, but it’s not always 
the best tool for every job. What the Clone Stamp does is it allows you 
to choose a particular point in your image by hovering over the area 
which you want to sample, holding down the Option key (Mac) or Alt key 
(Windows) and clicking on the spot of your choice. This is the area you 
will be sampling from.

Next, you’ll go to the area you want to remove and start painting. You’ll 
start to see that the area you are painting in is exactly copying the area 
from which you have sampled. You can adjust your stamp like you would  
the paintbrush tool, altering the hardness and even shape of the brush. 

While this works really well in many situations, the Healing Brush is 
more appropriate in others. To me, I like using the healing brush in skies 
and areas of soft gradients or similar color palettes. With the healing 
brush you’ll also want to sample an area first that you want to use as your 
reference point.

The Clone Stamp tool is a powerful way to remove unwanted objects from 
your scene as you can see in the two images above.
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Then, just like the Clone Stamp tool you will start painting on the area you 
want to alter. With this tool you are trying to blend the area seamlessly by 
taking into account the textures, lighting and shading of the sampled area 
and matching it to your desired location. While it may sound a lot like 
the Clone Stamp, it’s actually quite a bit different. The Healing Brush will 
often blur areas to soften and smooth them into matching the sampled 
region. You’ll quickly see as you start playing around with these two tools 
which ones are good for different circumstances. 

In addition to these tools, I’m also often using layer masks to mask out bits 
and pieces of spots that I’m trying to correct. There are other tools that I 
use on occasion too, such as the Content-Aware Fill, the Patch Tool and 
the Spot Healing brush. To me, however, the Clone Stamp and Healing 
Brush are the two essentials that get used far more than the rest. 

With that said, experiment with the other tools and see what works best 
for you and your images. You may find an even better technique to remove 
unwanted objects. By now you have a pretty big arsenal at your disposal. 
Don’t be afraid to use all your tools!

These two closeups show the difference before and after the Healing 
Brush is applied. You can see the sky on the right is much smoother.
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Sharpening Your Images
There's nothing quite like a tack sharp image. Although 
sometimes your images may need a little help getting 
really crisp. On the following pages you'll learn two of the 
techniques I use most often to get razor sharp pictures.



Sharpening Your Images
Sometimes if I take pictures at certain apertures, I get areas in my pictures 
that I want to be a little sharper. While it’s not possible with current DSLRs 
to fix aperture or focal areas after the shot, it is possible to add a little more 
crispness in Photoshop and Lightroom. 

In my opinion, it is better to sharpen your images in Photoshop. In fact, 
for most edits I like to work in Photoshop. I just think it does a little bit 
better job. 

While in Photoshop, there are a lot of different ways to sharpen an image. 
I mean, under Filter > Sharpen > there are six options alone. Starting with 

“Shake Reduction…” which, if 
you have camera shake in your 
image, you’re not really going 
to be able to fix that. In fact, the 
only option in there that I tend 
to use is the Unsharp Mask filter. 

The other option I do use with 
any regularity, is the High Pass 
filter, which is found under 
Filter > Other > High Pass. 
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What we have to understand about all of the methods of sharpening 
images in Photoshop is that essentially what we’re doing is creating 
contrast. We’re creating contrast between dark and light pixels, making 
the darks darker and the lights lighter.  This essentially makes your eye 
appear to see more detail in the overall image. 

When working with filters, a lot of people like to first make sure the layer 
they’re working on is converted to a smart object in order to make the 
filter editable later on. Although not necessary, there are a lot of benefits 
to this. To convert a layer into a smart object simply right click on image 
layer and select “Convert to Smart Object.” I tend to make a copy of the 
layer I’m working on too, just to keep the original in tact should I need it. 

Alright, let’s take a look at our two options.

What we have to understand 
about all of the methods of 
sharpening images in Photoshop 
is that essentially what we’re 
doing is creating contrast. We’re 
creating contrast between dark 
and light pixels, making the darks 
darker and the lights lighter.  This 
essentially makes your eye appear 
to see more detail in the overall 
image. 

When working with filters, a lot 
of people like to first make sure 

the layer they’re working on is converted to a smart object in order to 
make the filter editable later on. Although not necessary, there are a lot of 
benefits to this. To convert a layer into a smart object simply right click on 
image layer and select “Convert to Smart Object.” 
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Also note, that there is a correlation between the Amount and Radius 
sliders where increasing the value of one means you’ll probably want to 
decrease the value of the other.

The third slider, Threshold, is key. This slider dictates how much variance 
in values between neighboring pixels there must be in order to be affected 
by the above sliders. For example, if we start with a threshold of 0, the 
entire image will be sharpened. If we move that slider up a little, high 
contrast areas will be affected while low contrast areas will be left alone.

High Pass
Often times I find I prefer the results of this filter over the Unsharp Mask. 
Not always, but a lot of the time this gives me a more desirable image. 
There are a million different theories on these two filters online and in 
photography circles around the globe, and to be honest I really think each 
image is different and reacts differently. To me, the High Pass filter tends 
to leave the less contrasty areas alone a bit more than the Unsharp Mask. 
Thus, the filter affects edges and areas with sharper contrast a little more. 

You can see in the above two examples that just by moving the threshold 
slider slightly, the entire image is affected drastically.
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To use this filter, you’ll want to create a stamp of your visible layers by 
pressing Shift+Ctrl+Alt+E (Windows) or Shift+Command+Option+E 
(Mac OS). 

Next, go to Filter > Other > High Pass…

From there we only have one slider, Radius. If we move that slider all the 
way to the left, you’ll see in the preview window an area filled in a neutral 
gray. Don’t be alarmed, this is normal. We’ll deal with the gray image 
shortly. As you move the slider to the right you start to see highlights 
around the edges in your image.

You will want to be careful how much you adjust the radius here. This is a 
learning process. The more you do it the more you’ll be able to gauge where 
you like that radius on each different image. Like the Unsharp Mask filter, 
higher resolution images will need a larger radius than lower resolution 
images. Choose your desired radius and select OK.

Just like with the Unsharp Mask filter, the slider in the High Pass filter can 
alter the affected pixels significantly.

p h o t o s h o p :  s h a r p e n I n g  y o u r  I m a g e s

135



Now, you should see a mostly gray image with slight highlights along 
edges. In order to get the full sharpening experience, we’ll need to change 
the blend mode of the layer. There are three good options for this, and 
each has its own application. Those blend modes are Overlay, Soft Light 
and Hard Light. 

For me, I tend to use Soft Light or Overlay 
99% of the time. I think the results tend 
to be a bit more appealing and less harsh 
on the eyes. 

The final step, and this goes for the 
Unsharp Mask method as well, is to 
add a layer mask. With the mask I can 
paint away areas where I don’t want 
any sharpening at all or tone down the 
overall image. 

Sometimes I’ll change the layer opacity 
for this last part too. It’s really up to 
you. Find a method that works for your 
artistic vision and have at it! Good Luck!
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Blending Modes
I know we’ve mentioned blending modes before but I want to go a little 
deeper into what they are and what they do. And although you can set 
brushes and other tools to use blending modes, I want to focus solely on 
using them with layers.

To be honest, I could spend the remainder of the book talking about what 
each blending mode does and the technicalities behind them, but I really 
only use 7 of them regularly. These are the ones I’m going to focus on here.

In order to use blending modes with layers, you must first have at least 
two layers. In this case, let’s say we do have just two layers. With the top 
layer selected, click on the blending mode drop down menu. Here you’ll 
see 27 different options divided into 6 groups (each group separated by a 
dark line).
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The first group consisting of 
“Normal” and “Dissolve” are 
kinda on there own and don’t 
really have much to do with 
each other. The rest of the 
groups do. The Darken group 
of modes all have a darkening 
effect on the layers they’re 
applied to. The Lighten group 
lightens the layers below it. 
The Contrast group both 
darkens and lightens adding 
contrast. The Inversion group 
works by subtracting pixels 
from the active layer from 
equivalent pixels on the layer 
below. And the Component 
group affects the color or 
luminosity within the active 
and underlying layers.

Just like the opacity slider allows you to blend layers together by adjusting 
the translucency of different layers, blending modes use complex 
mathematical formulas to adjust how a selected layer blends with the 
layers below. If I start explaining exactly how they work you are sure to fall 
asleep, so I'll save you the agony. Just know that there is method to Adobe's 
madness with how these modes function. The great thing about blending 
modes is that they are easy to experiment with. If you don’t like the effect 
you’re getting from one mode, try another. To make it even easier, hold 
down the Shift + or Shift - to go through them even quicker.

I'll show you some examples of how each mode affects the same image, but 
for now, let's move on to the 7 modes that I use most often.
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Normal: I don't think the Normal mode 
needs too much explaining. If it does, 
well, I’m not sure I can help you…

Darken: In the Darken mode, if the 
pixels in the active layer are darker than 
those below it, they are kept opaque. 
If the pixels are lighter than those on 
the layer below, the lighter pixels are 
replaced with the darker ones. I rarely 
use this, but on occasion it comes in 
handy.

Multiply: This seems to be the best 
mode for darkening most of the time. 
Technically what this mode does is it 
takes and multiplies the luminance 
levels of the active pixels with the pixels 
of the layer below. 

For all the examples below, I 
took my main image and made a 
duplicate layer of the same image. 
Then I added the rainbow gradient 
on the side of that same layer. So 
the only difference between the 
two layers is the gradient on the 
right side of the top layer. Then I 
took the top layer and added the 
blending mode to it. 

Normal

Darken

Multiply
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Lighten: The Lighten mode is the direct 
opposite of the Darken mode, and works 
virtually the same… except the exact 
opposite. The lighter pixels here are kept 
and the darker ones are replaced.

Screen: This is similar to the Lighten 
mode, but it usually is a little brighter and 
smoother. This mode does with light colors 
what the Multiply mode does with dark 
tones.

Overlay: Overlay and Soft Light are the 
two modes I use most (Next to Normal of 
course). Overlay does a great job of giving 
just a little more contrast to your images by 
acting like a half strength Multiply mode 
for the dark tones and a half strength 
Screen mode for the lighter colors. Unlike 
the other modes in the Contrast group, 
Overlay also takes into account the brightness of the  layer below it when 
it does its calculations.

Soft Light: Essentially, Soft Light does 
the same thing as the Overlay mode, just 
a bit more subtlety. It does not take into 
account the layer below and the effects in 
the highlights and shadows can be a bit 
more transparent. This is a great mode to 
just add a subtle punch to your images.

Lighten

Screen

Overlay

Soft Light
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Focus Stacking
This image is the result of a 12 image focus stack. You can see it is sharp 
from the closest rocks in the foreground all the way back to the mountain 
in the distance. 



Focus Stacking
This is a highly advanced concept and can be quite complicated. However, 
if you are ready to take the next step, this is a great tool for your tool belt. 
Focus stacking doesn’t work on every image, and doesn’t work all the time. 
Personally, I don’t use it that often, but when the scene calls for it, it is an 
awesome way to really add depth of field to an image. 

Essentially, what we are doing with focus stacking is taking multiple 
images of a scene at different focal lengths and blending them together. 
What this does is it gives you an even greater depth of field than say a 
standard f22. The problem with it, is that it is not always that easy to blend 
the images together. Focus stacking works best when your scene consists 
of subjects that don’t move or are not affected by wind. 

Alright so how do we do it? Well, first we find a scene that works for focus 
stacking. Then what I do is I set my aperture to one of its sharpest settings. 
This usually puts me in the f8-f14 range. For this particular image I’m 
using an f10. Next, I set my camera on a tripod and make sure my lens is 
set to manual exposure. Now, I’ll set my focusing ring so that the focus is 
on the object closest to my lens. After I make sure my settings are correct, 
I’ll fire off my first shot, using a cable release. 

142

p h o t o s h o p :  F o c u s  s t a c k I n g



Once I review the shot to make sure it is exposed properly, there is no 
camera shake or anything else wrong with it, I’ll dial the focusing ring on 
my lens just a touch so that my focus distance indicator moves towards the 
infinity symbol. With my settings the same as the last image, I fire another 
shot. Then I adjust the focusing ring again towards infinity. I’ll repeat this 
process until I reach infinity. The key is to move the focusing ring just a 
hair each time. After a bit of practice and experimenting, you’ll see what I 
mean, and you’ll get a good feel for where you need to be. 

When you’ve shot all your images, you can then move them into Photoshop 
as individual layers.

Photoshop actually has a very easy option for blending images like this. 
In fact, this technique is quite common for macro photographers, though 
not so common for us landscape folks. With macro it is a bit simpler and 
the Photoshop "easy button," if you will, does a pretty good job. With 
landscape photography, it's more hit or miss. I’ve had it work for me once 
or twice, but usually I’ll have to take matters into my own hands.

All 12 image of this scene are brought in as layers into Photoshop. The top 
layer which is visible above shows the area closest to the camera as having 
the focus while the image becomes more and more blurry the farther into 
the background we look. 
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But before we go there, let’s 
try the Photoshop method 
and see if it works. First, 
import all of the images 
into Photoshop as layers. 
The select all layers (hold 
down the command  key 
for Mac, control key on 
a PC, and click on all the 
layers you wish to select). 
Go to Edit > Auto-Align 

Next, with all layers still 
selected, go to Edit > Auto-
Blend Layers… and make 
sure “Stack Images” is 
selected. I also leave the 
“Seamless Tones and Colors” 
and the “Content Aware 
Fill Transparent Areas” 
checkboxes checked. Then 
hit OK.

Layers… Once there, make sure “Auto” is the only thing selected in the 
popup menu and hit OK. It’s a good idea to use this feature any time you 
have multiple layers of the same scene in Photoshop, as it does a really 
good job of lining up the layers if they should be off for any reason.

Photoshop will render your layers with detailed masks. You’ll now need 
to zoom in on your image and really look closely at some of your detail 
areas. What you’ll be looking for is any blurry area where the layer masks 
intersect. Sometimes, it turns out really well, while other times it's just too 
much for Photoshop to process. 
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Hopefully, this works out and you’re now done with this image. Often 
times though, it’s not accurate and you’ll need to either adjust the masks 
that Photoshop made, or create new ones. Most of the time I like to create 
my own masks. I think I can get more accurate, and this makes a difference 
when you’re printing huge images. If this is just for likes on Instagram, 
well then heck, you’re probably going to be great  most of the time with the 
Photoshop renderings.

You can see in my rendering, Photoshop did a good job with the foreground, 
but the background is a mess. 

When zoomed in, you can see how awful the back ground is. We will need 
to adjust our masks by hand in order to get this right. 
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Sometimes it's really hard to blend these right. It may take days or weeks 
and you may need thicker glasses from staring at the computer for hours 
on end to get it right, but it’ll be worth it. If the image requires bracketing 
and focus stacking then you’re in for a real headache, but let me assure you 
it can be done. Sometimes you’ll have dozens of layers going and once you 
do finish, then you still have to add your adjustments or any additional 
manipulations onto the image, so your work is just beginning!

Before closing out this chapter, I do want to make note of a program that I 
find helpful for this type of photography. There are several available that do 
a good job, but one I’m pretty keen on is Helicon Focus. It’s worth looking 
into if you find Photoshop not up to par with their auto-blending options. 
Helicon Focus is actually built for focus stacking. Good luck, my friends!

After working the Photoshop layer masks a bit I was able to get a rendering 
that looked pretty good. The details are crisp throughout and the background 
is no longer butchered. With a few adjustment layers - Bam! - A great image!
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Orton Effect
Michael Orton became well known for creating dream like images by 
essentially adding a little blur to the overall image. What makes it so great 
is that he also was able to keep many of the details in focus. Today the 
'Orton Effect' is everywhere. Sometimes it is a little over used, but when 
done subtlely, it can be a great touch on landscape photos.

I use the Orton Effect at the end of my workflow. When I’m just about 
finished with an image, this becomes the final touch that sets it off. I don’t 
use it with every image, but with many of them I do, and the results are 
awesome! This is a great tool to add to your tool belt, so let's dive in and 
see how it works!

First, make sure you are on the top layer of your image. Again, you should 
be pretty much done with all your adjustments, layer masks, etc. before 
getting started with the 'Orton Effect'. 
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Then use the keyboard shortcut to make a copy of all visible layers onto 
one layer. On a Mac hold down the command, option, shift and the "E" 
keys (on a PC it will be the control, alt, shift and "E" keys). If you only have 
one layer in your document, then simply make a copy of that layer.

With that single merged layer selected, go 
to the top menu bar and under the “Image” 
tab, scroll down towards the bottom and 
click on “Apply Image…”.

When the dialog box pops up, make sure 
your settings are as follows: 

1) Layer: This should be the layer you are 
working on. In my case it is "Layer 18".

2) Channel: This should be the mode you are 
working in. In this case RGB.

3) Blending: Change this to "Screen".

4) Make sure Opacity is set to 100%.
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Next we'll want to duplicate 
this layer. The keyboard 
shortcut is Command + “J” 
(Control + “J” on a PC). With 
that layer selected, change the 
blending mode to “Multiply” 
in that first drop down box 
above your top layer. The 
multiply blending mode will 
create very dark shadows and 
add a lot of contrast to your 
image. Ah, but not to worry, 
we will fix this shortly...

Once everything is set correctly, press OK. The image will most likely look 
quite a bit lighter. This is normal, everything will come together in a few 
more steps. 
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Now, while still on that layer go to the “Filter” tab in the top menu bar and 
select “Blur” > “Gaussian Blur…”. Adjust the amount of blur to your liking, 
and click OK. I usually use a setting around 35 or so, depending on how 
large the file is. You may need to experiment a little with this to get it right. 
It will look a little strong at this point but we will fix that in the next step. 

Next, with the top layer 
selected, hold down the “Shift” 
key and select the second layer 
you created, directly below it. 
Press the Command + “E” keys 
(Control + “E” on PC) to merge 
the layers. Here I'll change the 
layer's name to "Orton" just to 
stay organized. Next, change 
the blending mode to “Soft 
Light.” In the “Opacity” drop 
down box above the layer, 
take the percentage down to 
around 35% or wherever you 
think it looks best. 
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Finally, you’ll want to create a layer mask by clicking on 
the layer mask icon on the bottom of the layers palette. 
Make sure your paintbrush tool is selected and black is 
your selected color. 

You'll most likely want to make sure you have a soft edge, 
round brush selected. You can change this by clicking 
on the icon next to the paintbrush on the top tool bar.

I also like to start with a low opacity of around 20% or 
so, just so that I can blend away the effect in a subtle 
manner. You can find the brush opacity slider in that 
same top tool bar a little further down.

Then, with your mask selected on your Orton effect 
layer, paint away the areas where you want more detail. 
This takes a little bit of practice and playing around, but 
it is an awesome effect that adds a fascinating feel to 
landscape images!
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You can see the softer, dreamier feel of the image with the applied Orton 
Effect on the image below as opposed to the image without above.152
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Plugins / Filters / Other Software

There’s a ton of plugins, filters and other software that work very well 
with Photoshop. There are also many programs that work well on their 
own.  Although I don’t regularly use any editing programs other than 
Photoshop, it is not the be-all and end-all. There are some awesome 
plugins from Nik Collection, Topaz Labs, Alien Skin and more. There 
are even some great programs that are designed specifically for photo 
stitching panoramics, HDR photography and even for focus stacking. 
I encourage you to explore all that you can get your hands on. It will 
help you to develop your own style and blossom as a creative and 
inspirational landscape photographer!
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Preparing Images for Print

I felt obligated to write a little something here because I see so many 
photographers that take great pictures and edit great images but their 
prints look terrible. Understanding how printers work is essential if 
you plan on taking your images to print. 

Before you do anything, it’s important to calibrate your monitor. 
Otherwise, what you see on your screen can be much different from 
what comes out of the printer. Whether you are printing at home 
or using a photo lab, always make sure your monitor is calibrated 
correctly. There are several monitor calibration tools out there, but 
essentially they all do the same thing. They put your monitor’s colors 
into a state that is understood by printing engines.

Knowing who you’re working with 
is the next step. Once you’ve chosen 
a printing lab you should be able to 
get a printer profile from them.  This 
is basically telling you what kind of 
printer they are using and what kind 
of specifications they’re looking for 
in your files. Many printers today 
will work off of RGB files, but many 
others work from CMYK. Your 

printer may tell you they use “sRGB” or “Coated GRACoL 2006.” Or 
they may have their own unique profile already setup for their printer. 
Sometimes the lab will send you a file containing their printer profile. 
Either way, when you’re setting your image in Photoshop, it’s a good idea 
to make sure you are using the same profile.

The Colormunki monitor 
calibration device from X-Rite
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To set your profile in Photoshop go to Edit > Assign Profile…  
Although, if you need to import a custom printer profile you would go 
to Edit > Color Settings… 

Once your color profile matches your printers profile, and your 
monitor is calibrated, there is one more step before the image is ready 
to print. In the top menu bar in Photoshop, go to View > Gamut 
Warning.  What this does is it provides a preview of your image with 
all the colors that your printer will have a hard time printing rendered 
as gray pixels. Sometimes you will have very few gray pixels, other 
times your image will be full of them.

What this means to you, is that all those pixels that are now rendering 
as gray would not be able to print accurately with the selected printer 
profile. Sometimes they will get close, other times it will be way off 
and you will lose all kinds of detail. To me, the best practice here is to 
adjust your image so that these gray pixels go away.

The gray areas in the above image are the gamut warning. What it is 
telling us is that the color in these areas are beyond what the selected 
printer is capable of. 



If that affects the image too much, you may want to try a different 
adjustment layer, such as Color Balance, Selective Color…, or Channel 
Mixer… However you decide to reduce your gamut warnings you will 
be better off when you do take the image to print. 

With just a few minor adjustments to the Hue/Saturation panel nearly 
all my gamut warnings are gone. 

“How do I do that,” you ask? There are many ways, and none better 
than any other, but a few that work for me. What I generally will do, is 
create a Hue/Saturation adjustment layer on top of the top layer in your 
file. Then you can select individual color ranges that are affected and 
start by adjusting the saturation slider to the left. Most of the time the 
gray pixels will go away if you slide it far enough. The downside is that 
your image becomes less vibrant. To refine this adjustment, you can 
use the layer mask to paint away areas that were unaffected. 
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When you are saving your images for print, you’ll also want to find 
out the file type your printer recommends for handling the files. Most 
of the time they’ll accept TIFF, JPEG and PDF files. All of which will 
produce good results. For me personally, I choose TIFF just because I 
know the file is going to contain as much information as possible and 
will have the best chance of coming out as accurately as the image I see 
on my screen. 

So, when I’m saving my file, I will choose to flatten all layers before 
going to print by going to Layer > Flatten Image. Then I go to File > 
Save As… I call my file something unique so that I don’t overwrite 
the file with all the layers. Then, I change the format type to TIFF and 
make sure the “Embed Color Profile” checkbox is checked. That’s it my 
friend, save away and get that thing printed!
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p h o t o g r a p h e r ' s  e t I q u e t t e

Photographer's Etiquette

I think this might actually be the most important part of the book, 
and yet it has nothing to do with skills, techniques or rules. Instead, it 
has everything to do with your behavior as a photographer and what 
it says to those around you. 

In my travels and here at home, I've seen too many photographers 
who are me-centric. Their shot is the only one that matters. They set 
up in front of your camera or they push others out of the way. They 
trespass on private property and damage sacred sites to take pictures. 
Please don't be one of those people.

We are here to capture the beauty of our planet, but not at the expense 
of making enemies or being ignorant. This is our planet to share for 
the short time we are here. 

Sometimes talking to someone politely can go a long way. Other 
times you may have to change your vantage point. There will always 
be those who believe they are more important, and their need to get 
a shot trumps yours. However, what I've noticed with many of the 
pro shooters I know is that great photographers are more like flies on 
the wall. They adapt. If a wedding shows up in front of their scene, 
they change their perspective. Rude attitudes, ignorance and violence 
should never mar the beauty we are trying to capture.

Always remember the "golden rule:" treat others the way you want to 
be treated. If you want to grow as a photographer, here's the best way I 
know how: Prepare for your shoot. Plan it out ahead of time. Get there 
early. If and when a wrench is thrown your way, adjust. Be humble, 
be courteous, be patient and forget the postcard shot. Find your own. 
Adapt. Do this, and you will be a great and respected photographer.
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Final Thoughts

This book is titled “The Landscape Photographer’s Field Guide” and 
it’s meant to be just that, a guide. The information, tips and techniques 
I’ve shared with you throughout this book are what I’ve found to be 
helpful in my photography. My intention with sharing this information 
is for you to get the basic understanding of the absolute essentials of 
landscape photography and hopefully a few new tools for your tool 
belt. This book is a starting point, within its pages is the information 
necessary to develop and grow as an amateur, intermediate and even 
an advanced photographer. As you progress, look outside this book, 
seek out other sources of information and create your own techniques 
that work to develop your style. 

Remember our Hawaiian proverb: A‘ohe pau ka ‘ike i ka hālau 
ho‘okahi - Not all knowledge is learned in one school.  Use this book 
as a guide, but seek to develop your skills beyond what you learn here. 
You are ready. Please begin…
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Mike Neubauer is an award-winning landscape photographer, 
author and humanitarian. He is also the founder of Earth Trot 
Galleries and The Earth Trot Project, a 501(c)(3) non-profit 
organization focusing on cultural and environmental advocacy.

When not traveling or behind the lens, Mike enjoys spending time 
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Questions, comments or ideas for Mike? Get in touch with him 
through his website at: Neubauer.net or email him directly at: 
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